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What is LabelCraft? 
LabelCraft is a powerful program for creating all types of 
labels in the Microsoft Windows environment.  
LabelCraft is easy to use. You can add text, graphics and 
barcodes to a label, and position them with a few mouse 
clicks. The program works with both ordinary laser 
printers and special label printers. 
LabelCraft gives you access to all True Type fonts available 
in Windows. There are many True Type fonts available, 
please contact your local Microsoft dealer for more 
information. 
This manual is not meant to be a Microsoft Windows 
tutorial. We assume that you have some experience using 
Windows. If you need more information, please consult 
your Windows manual. 
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Installing LabelCraft 
This software is protected with a hardware key, which must 
be plugged into the parallel printer port at the back of your 
PC. Without the key LabelCraft runs in demo mode. The 
following message is then shown when you choose Label 
Printing or Label Editing from the main menu: 

 

 
 

The demo version has the following limitations: 

• «Save» and «Save As» are disabled. 
• Some letters in text strings are mixed up. 
• Numbers are randomized (they will change all 

the time). 
• Graphics will be over crossed. 
 

Follow these steps to install LabelCraft on your computer: 

1. Find the LabelCraft hardware key, and insert it into 
the parallel port at the back of your PC. 

 If you already use the parallel port for your 
printer, unplug the printer and insert the 
hardware key. Then plug the printer into the key. 

2. Insert the LabelCraft diskette into your diskette drive. 

3. If you are running Microsoft Windows 95/98/NT, 
from the Start menu choose Run. 

4. In the text box Command Line, type a:\exlabel (you 
might have to change the drive letter, for example to 
b:\exlabel).  

5. Click OK. You see this window: 
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6. Click License Agreement to start the setup program. 
The program shows the agreement. 

 

 

7. Read the agreement. If you I agree Click I agree to 
continue the installation. To cancel the agreement 
select I don't agree and the installation will be 
aborted. 

8. When requested, specify the directory where you 
want to install LabelCraft. Unless you specify a 
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different directory, the application will be installed in 
C:\LABEL32. 

 NOTE! The setup program will overwrite any 
existing files in this directory. 

 

  
 

9. Click Next to start the installation. 
 

The setup program adds a program group called 
LabelCraft to the Program Manager. This group contains 
three icons: 

 Starts the LabelCraft main program. 

 Starts the ASCII File Server. 

 Starts the ODBC2000 program. 

 
 Starts the Print spooler program 
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 Starts the Print spooler program 

 Starts the uninstall program to remove the  
program 

 
 
If you are running Windows 95,98 and NT 4.0, these icons 
are added to the Start menu in a program group called 
LabelCraft. 
NOTE! 
When installing the system on a WinNT 4.0, Windows2000, 
Windows XP Home or Windows XP Pro.  a Sentinel setup 

program and the   icon is added to the program group. 
If this is the first time that you are installing this software 
on the computer you must run this program. Select the 
menu “Functions | Install Sentinel Driver”. Confirm all 
questions and the device driver that will allow us to find 
the copyright key (hardware key). If you have problems 
running the program make sure that you have the rights to 
install a device driver into the system. 
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Starting LabelCraft 
To open the program click on the Start button, select 
Programs, scroll down to the LabelCraft program and 
select LabelCraft.  
After first time the program will get local country from 
your operating system and set the language according to 
this. You will now see the main window: 

 

 

If you want to print labels that you have already designed, 
choose Label Printing.  
If you want to design a new label or edit a label, choose 
Label Editing. 
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Configuring your printer 
Before you can start using LabelCraft, you need to 
configure your printer(s). You can define up to four 
different printers that you can choose between when you 
want to print labels. 

1. Start LabelCraft and choose Label Editing from the 
main window. 

2. From the File menu, choose Modify Format. You see 
the ‘New Label’ dialog box. 

3. Click on the Setup button. You see the ‘Label Setup’ 
window. 

 NOTE! You can also activate this window by 
running LSETUP.EXE that was copied to the 
program directory during installation. 

4. In the Filename text box LabelCraft suggests 
‘PLABEL.CFG’. The configuration is saved in this file. 
You may change this if you need more than one 
printer configuration. If not, we recommend that you 
do not change the filename, since the name for this 
file is associated with the program name. 
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5. To set-up what output port to be using click on the 
button “Edit”. A dialog box will now be opened: 

 
Select with a radio button what port type to use. Each 
port type will have a corresponding dialog. Com port 
and Parallel port will look like the one that is shown 
above. 
TCP/IP port: 

 
TCP/IP connection is done by RAW TCP/IP format. 
When using TCP/IP make sure that your system will 
support this format. Make sure that the “Local Port” 
is set-up correct. 
Network resource: 

 
When using a network-shared resource this needs to 
be identified correct. Computer name is the network 
name for the computer that is sharing out his port. 
Shared port resource is the name you have setup in 
the printer driver. Note! To use this function you 
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must have enabled the system to share out its 
printers. On the example above we have setup the 
server on the system to share out a resource that is 
controlled by the server. In this example, it could 
have been a local printer port. There has been 
installed a printer driver that is assign to the port that 
you will connect the printer to. A note of caution, 
please use a simple driver as possible (Example: 
Generic Text only). When you are setting up the 
spooler setting of this driver make sure that you have 
setup the data format to be RAW. Other formats may 
generate extra characters to be sent to the printer that 
may result in damaged output by the printer. 
File/other: 

 
When you want to print to a file or using an USB 
device this is the port setting you are going to use. 
For printing to a file just insert the name of the file 
that that you want to generate. If you are going to use 
an USB port enter the port name in this text box 
(example: USB001). 

6. Select your printer from the Printer /Family from the 
drop-down list. If your printer is not found there or 
that it is not compatible with another printer you can 
connect to this printer by using its windows driver 
and LabelCraft’s generic Windows driver PWIN  

 If you want to use a generic Windows printer driver, 
select PWIN. LabelCraft then uses the default printer 
selected in the Windows Control Panel (unless you 
select NODEF or PDEF from the Parameters list - you 
are then prompted for printer before printing is 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 11

started or using the printer defined to that specific 
port (LPT6)). 

7. You now need to specify the printer parameters. This 
will vary from printer to printer. You select the 
parameters from the Parameters drop-down list.  
The printer parameters will often contain a ref to 
which model to be using as well as other special 
parameters that is available for this printer 

 NOTE! Click on the Info button for more information 
about the various parameters. 

8. Type the character table to use in the Character table 
text box.  

 NOTE! Click on the Info button, then Character 
codes or Country codes for a list of relevant codes. 

9. You have now completed the configuration of this 
printer. Repeat steps 5 - 8 to configure another printer. 

10. Click Save to save the setup configuration. 

11. Click Quit to close the window. 
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Defining the label format 
LabelCraft lets you store an unlimited number of label 
formats in separate files. You need to specify label width 
and height, number of columns and rows, margins and the 
printer to use. 

1. From the File menu choose Modify Format. You see 
the ‘New Label’ dialog box. 
Please note that this dialog box will vary depending 
on what the selected model will support. 

2. The cursor is in the Stock type text box. Here you 
specify the filename. 

 

 
 

3. Empty the Label Width and Label Height text boxes. 

4. Move the cursor to the No. of columns text box. Type 
the number of labels across the page, for example 3. 

5. Press the TAB key. The cursor in now in the No. of 
rows text box. Type the number of labels down the 
page, for example 10. 
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6. Click on the printer you want to use in the Target 
printer list.  

 LabelCraft fetches the page format for the selected 
printer and calculates the width and height of the 
label. The result is added to the Label Width, Label 
Height, Horizontal pitch and Vertical pitch text 
boxes. 

 

  

7. If you want a horizontal gap between labels, you 
need to tell LabelCraft this. Default there is no gap. 
In the text box Horizontal pitch, type the label width 
plus the gap, for example 70 (mm). 
NOTE! If you are using columns across the web and set 
the Horizontal pitch to be “0” you will only print one label 
across the web. 

8. If you want a vertical gap between labels, you need to 
tell LabelCraft this. Default there is no gap. 
In the text box Vertical pitch, type the label height 
plus the gap, for example 30 (mm). 
NOTE! If you are using rows across the web and set the 
Vertical pitch to be “0” you will only print one label across 
the web. 

9. If you want a gap from the left of the page to the left 
side of the first label column, you need to tell 
LabelCraft this. Type the gap in the text box Label 
left origin, for example 10 (mm). 

10. If you want a gap from the top of the page to the top 
of the first label row, you need to tell LabelCraft this. 
Type the gap in the text box Label top origin, for 
example 20 (mm). 
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11. If you want to skip some labels on the first page, type 
the number of labels to skip in the No. empty labels 
box. This allows re-use of partial sheets of labels. 

12. To save the format, click the Save button. If you have 
specified a filename in the Stock type text box, the 
format is now saved. If not, you see the ‘Save As’ 
dialog. 

13. Select the drive and directory where you want to save 
the format if it is different from the LabelCraft 
directory. 

14. In the Filename text box give the format a name. The 
file extension .STK, is added automatically. 

15. Click OK. You have now defined and saved the label 
format. The next time you want to create a new label, 
simply click Open and select this file. You can then 
use the format immediately. 
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Making a new label 
To help you get started, this section contains an example 
showing how to make a simple label with one text field. 
Always follow the main steps described below when you 
want to create and print a new label. 

STEP 1: The label format 

1. Start LabelCraft and choose Label Editing from the 
main window. You see the ‘Label Editor’ window. 

2. From the File menu choose New. You see the ‘New 
label’ dialog box. 

3. If you have already defined a label format, click 
Open and select the file. Then click OK. To continue, 
move to ‘STEP 2: Add a field to the label’. 

4. If you need to define a new label format, see the 
section ‘defining the label format’. 
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STEP 2: Add a field to the label 

1. Click on the single-line text field icon , or choose 
Text from the Field menu. You see the ‘Text Field’ 
dialog box. 

2. In the Content text box, type the text you want on the 
label. For example ‘Test label’. 

 

 
 

3. From the menus, select the font and font style you 
want to use. 
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4. Click on OK. You see that LabelCraft has placed the 
text field on the label. Position the text field by 
dragging it with the mouse. 

 

 

STEP 3: Save the label 

1. From the File menu choose Save. You see the ‘Save 
As’ dialog box. 

2. Select the drive and directory where you want to save 
the label if it is different from the LabelCraft directory.  

3. In the Filename text box give the label a name. The 
file extension identifying the label file, .LBL, is added 
automatically. 

4. Click OK. The label is now saved. 
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STEP 4: Print the label 

 
 

1. Click Print on the menu-bar or click on the print icon 

. You will now see the ‘Print Options’ dialog box. 
 

 
 

2. Select the printer you want to use. 
Note! If the format has specified to use PWIN.DRV 
you will only be able to select a printer with the same 
driver (PWIN). If you have two printers with the 
same parameter you will be able to select both 
printers. Example: Printer 1 are connected to LPT1 
and printer 2 are connected to LPT2. When setting 
No. Labels to be 6. You will be printing 6 labels to 
each printer automatically.  

3. Click OK to print the label. 
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Field types 

Single-line text field 

 The single-line text field contains just one line of text. There 
are five types of single-line text fields: 

• Fixed field 
• Variable field 
• Field with text from another field 
• Field containing special date commands 
• Field with text from an external data source 
• Field with formula calculations, see LabelCraft 

/ LabelCraft Reference Guide :  Formulas 
 

In this example, you will create a label with all the five 
different types of fields. The finished label will look like 
this: 
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Choosing the label format 

Follow these steps to make sure that everything is set up 
correctly before you start adding the fields: 

1. From the File menu choose New. You see the ‘New 
Label’ dialog box. 

2. If you have already defined a label format, click 
Open and select the file. 

3. If not, specify the relevant format details. If you need 
more information, see ‘Defining the label format'. 

4. Start the ASCII File Server. Make sure that  
- the servername is set to ‘LABELSERVER’ 
- the topic name is set to ’LABELDATA’ 
- the file to read data from is ’TEST.TXT’ (this file 

was copied to the program directory during 
installation). 

5. Minimize the ASCII File Server window. 

6. In the ‘New Label’ dialog box, click Database info. 

7. Make sure that name and topic for database server 1 
is set to ‘LabelServer’ and ‘LabelData’. Click OK to 
close the dialog. 

8. Click OK. You see a new empty label. 
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Adding a fixed field 

A fixed field always contains the same information, for 
example a company name. 

1. Click on the single-line text field icon , or choose 
Text from the Field menu. You see the ‘Text Field’ 
dialog box. 

2. Type ‘LabelCraft’ in the Content text box. 
 

 
 

3. Move the cursor to the Name text box and write 
‘Fixed’. 

4. Make sure that the Type is set to Fixed. 

5. Click OK to add the field to the label. 
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Adding a variable field 

A variable field lets you specify what text to print each 
time you print the label. 

1. Click on the single-line text field icon , or choose 
Text from the Field menu. You see the ‘Text Field’ 
dialog box. 

2. Move the cursor to the Name text box and write 
‘Variable’. 

3. Make sure that the Type is set to Variable. 

 
 

4. In the Format text box, type ’Customer no: ^^^^^’ 
(hold down ALT while you type 0094 on the numeric 
keyboard to generate a ‘^’). This tells LabelCraft to 
only accept digits as the customer number. 

5. Press the TAB key to move the cursor out of the text 
box. LabelCraft automatically adds ‘Customer no: 
00000’ to the Content text box. 

6 Click OK to add the field to the label. 
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Adding a field with text from another field 

This field gets the text from another label field. 

1. Click on the single-line text field icon , or choose 
Text from the Field menu. You see the ‘Text Field’ 
dialog box. 

2. Make sure that the Type is set to From other field. 
 

 
 

3. From the Field name list select Variable. The content 
of this field is automatically added to the Content 
text box. 

4. In the Start position text box, type ‘14’. This tells 
LabelCraft that the first 13 characters from the 
‘Variable’ field are not to be included in this field. In 
this case, it means that only the customer number is 
included (not the text ‘Customer no:’). Select Fixed 
field length to ensure that LabelCraft uses the start 
position and the correct no. of  * in the format text 
box. 

5. Click OK to add the field to the label. 
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Adding a field with text from a database 

This field gets the text from an external data source; either 
the ASCII File Server or the ODBC Server. 

1. Click on the single-line text field icon , or choose 
Text from the Field menu. You see the ‘Text Field’ 
dialog box. 

2. Set Type to From database no.. Make sure that you 
tell LabelCraft to fetch data from database server no. 
1. 

 

 
 

3. From the Field name list, select Allname.  

4. Click Get data. The ASCII File Server fetches the text 
from the first line in the data file and places it in the 
Content text box. 

5. Click OK to add the field to the label. 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 25

Adding a field with special date functions 

This field gets the text from an own dates menu that is 
reached by it's own button in the new Text field window. 

1. Click on the single-line text field icon , or choose 
Text from the Field menu. You see the ‘Text Field’ 
dialog box. 

2. Set Type to Fixed. Click on button Dates….. 
 

 
 

3. From the menu, shown below make the selections 
and click OK.  
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4. To select an auto-code click on it and press button 
Append or Insert. This makes the selected auto-code 
into a chosen one. (PS! You can also double click on a 
code to select it). 

5. Click OK to add the auto-code in to the field. Then 
click OK to add the field to the label. 

Printing the label 

You are now ready to print the label.  

1. Click Print on the menu-bar. 
Since the label contains one variable text field, you 
need to specify what this field will contain. 
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2. The field you work on will be inverted. This is 
convenient if you have more than one variable field. 

 

 
 

3. Type the customer number you want to print, for 
example ‘00883’. 

4. Click Print on the menu-bar. You see the ‘Print 
Options’ dialog box. 

5. Select printer and click OK to print one label. 
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Multi-line text field 

 The multi-line text field can contain several lines of text. 
This field is very useful for addresses.  

In this example, you want to add a field where tabulators 
are used to create a table. The finished label will look like 
this: 

 

 
 

1. Create a new empty label by choosing New from the 
File menu. 

2. Click on the multi-line text field icon , or choose 
Multi-line Text from the Field menu. You see the 
‘Multi line textfield’ dialog box. 

3. Ensure that the Type is set to Fixed. 
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4. In the Content text box:  

 - Write ‘Col 1’, press Ctrl+I, write ‘Col 2’, press 
Enter 

 - Write ‘1‘, press Ctrl+I, write ‘2’, press Enter 
 - Write ’3’, press Ctrl+I and write ‘4’. 

 NOTE! Ctrl+I inserts a tabulator stop. 
 

 
 

5. Adjust the tabulator position for column two. You do 
this by clicking on the dotted line in the box TAB 
positions. A ’t’ appears to indicate the tabulator. You 
can remove the tabulator by clicking on the ’t’. 

6.  Click OK to add the field to the label. 

7. To print the label, click Print on the menu-bar. You 
see the ‘Print Options’ dialog box. 

8. Select printer and click OK. 
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Barcode field 

 LabelCraft can handle several barcode types. If the printer 
cannot print the code from its internal code generator, 
LabelCraft can print the barcode as graphics. This may, 
however, be slower. 

In this example, you will create a label containing one fixed 
barcode field. The finished label will look like this: 

 

 
 

1. Create a new empty label by choosing New from the 
File menu. 

2. Click on the barcode field icon , or choose 
Barcode from the Field menu. You see the ‘Bar code’ 
dialog box. 

3. Ensure that the Type is set to Fixed. 
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4. From the Type menu choose EAN 13. LabelCraft 
automatically adds 13 ‘^’-characters in the Format 
text box. This means that the Content text box can 
only accept digits. 
If EAN 13 is shown in Grey (it is not supported by 
the printer’s internal code generator), select Print as 
bitmap before you choose from the menu. This tells 
LabelCraft to print the barcode as graphics. 

 

 
 

5. In the Content text box, type ‘123456789’. The last 
digit is in this case a calculated value, and will in be 
set to ’5’. 

6. Click OK to add the field to the label. 

7. To print the label, click Print on the menu-bar. You 
see the ‘Print Options’ dialog box. 

8. Select printer and click OK. 
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Autonumbering text field 

 An autonumbering text field is a text field that 
automatically generates ascending or descending serial 
numbers when the label is printed. 

In this example, you will create a label containing one fixed 
autonumbering text field. The finished label will look like 
this: 

 

 
 

1. Create a new empty label by choosing New from the 
File menu. 

2. Click on the autonum text field icon , or choose 
Autonum text from the Field menu. You see the 
‘Autonumbering text’ dialog box. 

3. Ensure that the Type is set to Fixed. 
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4. In the Format text box, type ’^^^^^’ (hold down ALT 
while you type 0094 on the numeric keyboard). 

 

 
 

5. In the Content text box, type ‘00115’. This tells 
LabelCraft to start printing at this number. 

6. In the Repeat box, type ’2’ in the Group size text box 
and select Batch. This tells LabelCraft to print two 
labels with each number. 

7. Type ’5’ in the Step size text box and select Up. This 
tells LabelCraft to add 5 to the number each time a 
new number is generated. 

8. Click OK to add the field to the label.  
 The ‘Auto Num. Info’ dialog box that gives you 

information about sequential numbering may be 
shown. If so, just click OK to close the dialog box. 

9. To print the label, click Print on the menu-bar. You 
see the ‘Print Options’ dialog box. 

9. In the No. Labels text box, type ’4’. 

10. Select printer and click OK. LabelCraft prints four 
labels with these numbers: ‘00115’, ‘00115’, ‘00120’ 
and ‘00120’. 
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Autonumbering barcode field 

 The autonumbering barcode field is similar to the 
autonumbering text field, except that it generates a number 
that is used to create a barcode. In this example, you will 
create a label containing one fixed autonumbering barcode 
field: 

 

 
 

1. Create a new label by choosing New from the File 
menu. 

2. Click on the autonum barcode field icon , or 
choose Autonum barcode from the Field menu. You 
see the ‘Autonumbering barcode’ dialog box. 

3. Ensure that the Type is set to Fixed. 

4. From the Type menu choose EAN 13. LabelCraft 
automatically adds 13 ‘^’-characters in the Format 
text box and ’0000000000000’ in the Content text box. 

 If EAN 13 is shown in Grey (it is not supported 
by the printer’s internal code generator), select 
Print as bitmap before you choose from the menu. 
This tells LabelCraft to print the barcode as 
graphics. 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 35

5. Click OK to add the field to the label. 

6. To print the label, click Print on the menu-bar. You 
see the ‘Print Options’ dialog box. 

7. In the No. Labels text box, type ’10’. 

8. Select printer and click OK. LabelCraft prints ten 
labels with one barcode each, created from the 
autonumbering field. 

Rectangle 

 You can draw a rectangle on the label. The rectangle can 
easily be scaled in all directions. In this example, you will 
create a label containing one rectangle. The finished label 
will look like this: 

 

 
 

1. Create a new empty label by choosing New from the 
File menu. 

2. Click on the rectangle field icon , or choose 
Rectangle from the Field menu. You see the 
‘Rectangle’ dialog box. 

3. In this dialog box you can specify the width and 
height of the rectangle. However, it is quicker to scale 
the rectangle after you have added it to the label. 
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4. If you want a different line width than the default 
width, type it in the Line width text box. In the 
screenshot above, the width is set to 2 mm.  

5. Click OK to add the rectangle to the label. 

6. To scale the rectangle, place the pointer on one of the 
sizing handles, press the left mouse button and drag 
to the size you want. 

7. To print the label, click Print on the menu-bar. You 
see the ‘Print Options’ dialog box. 

8. Select printer and click OK. 

Line 

 You can draw a vertical or horizontal line on the label. You 
can easily change the width and length of the line. 

In this example, you will create a label containing one line. 
The finished label will look like this: 

 

 
 

1. Create a new empty label by choosing New from the 
File menu. 

2. Click on the line field icon  , or choose Line from 
the Field menu. You see the ‘Line’ dialog box. 
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3. In this dialog box you can specify the width and 
length of the line. However, it is quicker to scale the 
line after you have added it to the label. 

4. Click OK to add the line to the label. 

5. To scale the line, place the pointer on one of the 
sizing handles, press the left mouse button and drag 
to the size you want. 

6. To print the label, click Print on the menu-bar. You 
see the ‘Print Options’ dialog box. 

7. Select printer and click OK. 

Circle 

 You can draw a circle on the label. You can easily change 
the width and height of the circle (makes it elliptical). 

In this example, you will create a label containing one cirle. 
The finished label will look like this: 

 

 
 

1. Create a new empty label by choosing New from the 
File menu. 

2. Choose Circle from the Field menu. You see the 
‘Circle’ dialog box. 
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3. In this dialog box you can specify the radius and 
circle vertical radius. However, it is quicker to scale 
the Circle after you have added it to the label. 

4. Click OK to add the circle to the label. 

5. To scale the circle, place the pointer on one of the 
sizing handles, press the left mouse button and drag 
to the size you want. 

6. To print the label, click Print on the menu-bar. You 
see the ‘Print Options’ dialog box. 

7. Select printer and click OK. 

Imported graphics 

 LabelCraft can handle graphics in *.BMP, *.PCX, *.MSP, 
*.WMF, *.JPG, *.JIF and *.GIF formats. You can scale 
graphics to any size. 

In this example, you will create a label containing one fixed 
graphic field. The finished label will look like this: 
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1. Create a new empty label by choosing New from the 
File menu. 

2. Click on the graphic field icon , or choose Graphic 
from the Field menu. You see the ‘Graphic field’ 
dialog box. 

 

3. Ensure that the Type is set to Fixed. 

4. Click Import image. You see the ‘Open’ dialog box. 

 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 40 

5. Select the file ‘SKULL.BMP’ and press OK. This file 
was copied to the program directory during 
installation. 

6. You will now see a dialog for converting color 
graphics to dithered image. 

 
You are able to set up the dithering and to add more 
brightness to the image. 

7. Click OK to add the image to the label. 

8. To scale the image, place the pointer on one of the 
sizing handles, press the left mouse button and drag 
to the size you want. 

 

9. To print the label, click Print on the menu-bar. You 
see the ‘Print Options’ dialog box. 

10. Select printer and click OK. 
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Editing the label fields 

Select 

To use most of the field commands on the Edit menu (like 
Edit, Copy and Rotate field) you must first select the 
field(s) you want to edit. When a field is selected, small 
squares called sizing handles appear around the field: 

 
To select one field 
Simply click on the field. 

 

To select several fields 
Hold down Shift while you click on each field. 
or 
Hold down the left mouse button to draw a rectangle 
around the fields you want to select. When you release the 
button, the fields inside the rectangle are selected. 
NOTE! To de-select all fields, just click outside the selected 
fields with the mouse button. 

Move 

In LabelCraft there are two ways to change a field’s 
position: 
With the mouse 
Position the pointer somewhere inside the field, press the 
left mouse button and drag while you hold down the 
button. LabelCraft draws a rectangle to indicate the new 
position while you drag. Release the button to actually 
move the field. 
With the keyboard 
Simply use the arrow keys. 
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NOTE! If you select more then one field, all selected fields 
are moved. 

Resize 

To resize (scale) a field, first select it, then click on one of 
the sizing handles, and hold down the left mouse button 
and drag. 

 
Resizes the field horizontally 
Resizes the field vertically 
Resizes the field both horizontally and vertically 

 

NOTE! It is not possible to manually resize a text field if 
you have selected Size in points. 
NOTE! Not all internal printer fonts are scaleable. 

Change properties 

In LabelCraft there are two ways to change the properties 
of a field (for example font, text or formatting codes): 

1. Double-click inside the field. 
 or 

2. Select the field and choose Edit from the Edit menu. 
You see the dialog box where you can change the 
properties. 
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Align fields 

You can align fields relative to each other. Once you have 
selected the fields you want to align, choose Align from the 
Edit menu and select the type of alignment: 

 Align left edges 

 Align top edges 

 Align right edges 

 Align bottom edges 

 Align horizontal center 

 Align vertical center 
NOTE! All fields are aligned relative to the last field you 
selected. This field has black sizing handles. 

 

 
 

Align on Label 

You can align fields relative to the Label border. Once you 
have selected the field(s) you want to align, choose Align 
on Label from the Edit menu and select the type of 
alignment: 

 Align to the left side of the Label 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 44 

 Align to the top of the Label 

 Align to the right side of the Label  

 Align to the  bottom of the Label   

 Align to the horizontal center of the label 

 Align to the vertical center of the label  
 
 
 

Delete 

To delete one or more fields: 

1. Select the field(s) you want to delete. 

2. Choose Clear from the Edit menu (or press the Del 
button on the keyboard). 

Right click menu 

When you are in the edit window of LabelCraft, you are 
able to reach shortcuts by right click on your mouse. 
If no fields are selected you will be able to do the following 
features: 

 
• Add a new field to the label 

• Lock current field 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 45

• Lock all fields on the label 

• Unlock all fields on the label 

• Paste if you have data on the clipboard 

• Print the label 

• Test print the label 

• Modify the label format 
 
If you have selected a field you will se the following 
options to be available: 
 

 
• Copy the selected field(s) 

• Paste the selected field(s) 

• Cut the selected field(s) 

• Rotate field 1° 

• Rotate field 90° 

• Lock current field 

• Lock all fields 

• Align fields 

• Align fields on label 

• Properties (on selected field) 

• Unselect All 
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Printing labels 

Test print 

When you have designed a label and want to print just one 
copy as a test, simply click "Testprint" on the menu-bar, 
press the button "F2" on the keyboard or right click in the 
edit window and select menu option "Test print".  

From the main window 

If you have already designed the label you want to print, 
you can start printing from the main window (the first 
window you see when you start LabelCraft). Simply click 
Label Printing to start the print module. 
NOTE! If the edit module is password protected and you 
do not know the password, you must choose Label 
Printing in the main window to print labels. Without the 
password, you cannot start the edit module. 

1. Click File and Load on the menu-bar. You see the 
‘Open’ dialog box. 

 

 
 

2. Select the label you want to print and click OK. 

3. Click Print on the menu-bar. You see the ’Print 
Options’ dialog box. 
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4. Select the printer you want to use. If you want to 
print to a file, select File and type the filename.  

 

 
 

5. Specify the number of labels to print in the text box 
No. labels. 

6. Click OK to start printing. 
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From the ‘Label Editor’ window 

To print labels from the ‘Label Editor’ window: 

1. Click Print on the menu-bar, short cut key "Ctrl + P" 
or right click in the edit window and select the menu 
option "Print…". You will then see the ‘Print Options’ 
dialog box. 

 

 
 

2. Select the printer you want to use. If you want to 
print to a file, select File and type the filename.  

 

 
 

3. Specify the number of labels to print in the text box 
No. labels. 

4. Click OK to start printing. 
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Using password protection 
You can password-protect the edit module to prevent 
unauthorized users from changing the label designs. All 
user can still print labels, but they will need a password to 
edit existing labels or create new ones. 
NOTE! Write down the password. There is no way to find 
it if you forget it. 

Add password 

1. Choose Options from the Edit menu. You see the 
‘Options’ dialog box. 

2. Click Change password. You see the New password 
text box in the same dialog box. 

 

 
 

3. Type the password. 

4. Click OK. The password is now active. 
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Change password 

1. Choose Options from the Edit menu. You see the 
‘Options’ dialog box. 

2. Click Change password. 

3. You need to type your current password. 

4. Click OK. You see the New password text box. 

5. Type the new password. 

6. Click OK. The new password is active. 

Remove password 

1. Choose Options from the Edit menu. You see the 
‘Options’ dialog box. 

2. Click Change password. 

3. You need to type your current password. 

4. Click OK. You see the New password text box. 

5. Do not type anything in the New password box (let it 
stay empty). 

6. Click OK. LabelCraft removes the password.  
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LabelCraft Reference Guide 

Main Window 

When you start LabelCraft, you see the main window: 
 

 
 

Label Printing Press this button to print labels you have already designed. 
For more information, see ‘The print module’. 

Label Editing Press this button to design a new label or edit a label. 
Quit Press this button to exit the program. 
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‘Label Editor’ window 

You design new labels or edit labels in the ‘Label Editor’ 
window:  

 

 
 

The various menu options are described below. Some 
dialog boxes that can be accessed through several of the 
menu options are described at the end of the chapter. 

File | New 

Use this menu option to create a new label. 
When you choose File | New, you first see the ‘New label’ 
dialog box where you define the label format. For more 
information, see ‘File | Modify Format’. When you have 
defined the format, you are ready start to design the label. 
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File | Open: ‘Open’ dialog box 

Use this menu option to open a previously saved label. You 
can use Ctrl+O as a shortcut. 
When you choose File | Open, you see the ‘Open’ dialog 
box. 

File name Type the name of the label file you want to open. 
Directories Select the directory where the label file is located if it is 

different from the LabelCraft directory. 
List files of  
type LabelCraft lists only files with the selected file extension. 

By default, only files with the extension .LBL are listed. 
Drives Select the drive where the label file is located. 
Network... The Network button can be used when the file is located on 

a network drive, which has not yet been defined as a 
logical drive. 

File | Save 

Use this menu option to save the label to a file. You can use 
Ctrl+S as a shortcut. 
When you choose File | Save, the label is saved to the 
currently open file. If the file name is not yet specified, you 
see the ‘Save As’ dialog box. This dialog box is described 
below. 

File | Save As: ‘Save As’ dialog box 

Use this menu option to save the label to a new file. 
When you choose File | Save as, you see the ‘Save As’ 
dialog box. 

File name Give the label file a name. 
Directories Select the directory where you want to save the label file if 

it is different from the LabelCraft directory. 
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List files of  
type LabelCraft lists only files with the selected file extension. 

By default, only files with the extension .LBL are listed. 
Drives Select the drive where you want to save the label file. 
Network... The Network button can be used when the file is located on 

a network drive, which has not yet been defined as a 
logical drive. 

File | Print: ‘Print Options’ dialog box 

 Use this menu option to print the label. You can use Ctrl+P 
as a shortcut. 

When you choose File | Print, you will see the ‘Print 
Options’ dialog box: 

 

 
 

Printer Select the printer you want to use if more than one printer 
is connected to the computer. If you have two identical 
printers 
The printers must be configured by the setup software. For 
more information, see ‘The setup module’. 

Sub printer  
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number Specify the sub printer number. This text box is only 
available if the printer has a multi-drop function. 

File If you want to send the label to a file instead of the printer, 
select File. Type the name of the file in the text box. 

Append to  
file Select this box to append the label to an existing file. If not, 

the file is overwritten. This option has no effect if the file 
does not already exist. 

No. Labels Specify the number of labels to print. 
Cut after job Select this option to automatically cut the paper after the 

print job is finished.  
 NOTE! This will only work for some Thermal Transfer 

printers with a cutter installed. 
Cut after each Select this option to cut after each printed label.  
 NOTE! This will only work for some Thermal Transfer 

printers with a cutter installed. 
Cut after no.   
printed If you want the paper to be cut after a specified number of 

labels are printed, type this number here.  
 NOTE! This will only work for some Thermal Transfer 

printers with a cutter installed. 
No. blank labels  
after print job Specify the number of blank labels to be included after the 

print job is finished. 
 

File | Stop Print 

Use this menu option to stop the print job.  
NOTE! This command will only be supported on printer 
models that allows this function. 
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File | Modify Format: ‘New label’ dialog box 

Use this menu option to change the label format. 
When you choose File | Modify Format, you see the ‘New 
label’ dialog box: 

 
 

NOTE! The options shown in the right part of the dialog 
box depends on the selected printer. When PWIN is 
selected, no special options are available. 

Stock type In this text box you type the label format’s file name. 
Open... Press this button to open a format file. You see the ‘Open’ 

dialog box. Select the file you want to open and click OK. 
Save... Press this button to save the format.  
 If no file name is specified in the Stock type text box, you 

see the dialog box ‘Save As’. Type the file name and press 
OK. 

Alias Press this button to show an Alias for the printer. To add a 
printer alias you must select the button “Setup” and add an 
alias there by pressing the button “Alias” and add the Alias 
into the corresponding text box. 

Password 
protected This function will enable password protection on the 

current label. Whenever you are to print or edit this label 
you must enter the password that has been set in the 'Edit 
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| Options'. If no password has been added this function 
will not work. 

Target printer Select the printer you want to use. This can be overridden 
in the ‘Print Options’ dialog box if you have more than one 
printer of the same brand. 

 NOTE! If you select a printer while the Label Height and 
Label Width text boxes are empty, LabelCraft uses the page 
format to calculate the maximum width and height of the 
label. The result is added to the Label Height and Label 
Width text boxes. 

Label Width Type the width of the label. 
Label Height Type the height of the label. 
No. of  
columns Type the number of label columns. 
No. of rows Type the number of label rows. 
Horizont.  
pitch If you want a horizontal gap between labels, type the gap 

plus the label width in this text box. 
Vertical pitch If you want a vertical gap between labels, type the gap plus 

the label height in this text box. 
Label left  
origin If you want a gap from the left edge of the page to the left 

side of the first label column, type the gap in this text box. 
Label top  
origin If you want a gap from the top edge of the page to the top 

of the first label row, type the gap in this text box. 
No. empty  
labels Specify the number of labels to skip on the first page. This 

allows re-use of partial sheets of labels.  
Print speed Specify the print speed. This will only work on printers 

that support software temperature and speed settings. 
Continuous 
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label This function will be shown when the printer support the 
usage of continuous label material. 

Sensor This function will be shown when the printer support 
software setting of sensor type to be using. 
NOTE! On some printer brands the usage of wrong sensor 
will stop the printer from functioning. It is very important 
to know what sensor your printer will support. 

Media type This function will be shown when the printer support the 
usage of different medias (Thermo Transfer- or Thermo-
labels). 

Print mode This function will be shown when the printer support 
different print modes (Retract, No retract. Tear off, 
Rewind,….). 

 
Ignore  
date/time  
fields Select this option to ignore date/time fields coming from 

the PC and treat these fields like normal text. This can 
speed up the printing. 

Database  
info... Click this button to specify database information. For more 

information, see ‘Label database information’. 
Extra info... Click this button to activate the ’Printer dependent label 

parameters’ dialog box. This dialog box contains important 
information about the printer driver setup.  

 
For Driver Info click on the button 'Driver Info…'. 
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Setup... Click this button to configure the printer(s). For more 
information, see ‘The setup module’. 

 

File | Change Label Name 

Use this menu option to change the label name without 
saving. 
File | Make all fields fixed 

Use this menu option to make all database fields fixed. This 
will not change the field format from Variable to Fixed on 
non database fields. 

 

File | Setup 

Use this menu to modify LabelCraft view and LabelCraft 
options. 
When you choose File | Setup , you see a dialog box where 
you can change the settings of LabelCraft. 

File |Setup … View modes 
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For the view modes please see the explanations under view 
| ??? 
for a more detailed description.  

File |Setup … Logging 

Selecting the tab marked Logging you will see following 
dialog box. 

 

Log file path In this text box you enter the name of the log file, by 
default this is placed in the same catalog as the program. 

Log print If you want a vertical gap between labels, type the gap plus 
the label height in this text box. 

Log variable  
fields during  
print This function activates the logging of data that has been 

entered into variable field when printing.                       
Log printer  
driver and  
printer device This function log what printer driver and what printer 

device is used when printing a label.   
Log prog. start This function makes a log entry whenever you start the 

program. 
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Log prog stop This function makes a log entry whenever you make a 
controlled stop of the program. 

 

File |Setup … Options 

Selecting the tab marked Options you will see following 
dialog box. 

 
Sort variable  
field by name Selecting this option enable the sorting of variable fields, 

based on the field names, when printing a label. The sort is 
done alphanumerical. Example 'Field1', Field2' and 'Field3' 
will be view in this order. 

Default  
Barcode By selecting a barcode you are setting up the default 

barcode that you will open whenever you adding a new 
barcode on the label. 

Activate  
spooler Selecting this option will enable the usage of Windows 

printer spooler. This will result in faster printing from 
LabelCraft. This function will only be shown in Windows 
95/98 and Me 
NOTE! If you are printing on a network controlled 
printer (a shared printer or where the spool queue are 
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controlled by another unit) this function must be 
disabled!!!!! 

Enable print 
Print to many 
Printers This function will enable you to print to more than one 

printer with the same parameters in the driver setup. 
Display 
Printer alias This function will display the printer alias in the dialog 

boxes “ New label” and in the “Print modul”. To use Alias 
see “File | New label” 
 

Allow to print 
On printers with 
Different 
parameters This function will in addition to the function “Allow to 

print to more than one printer” allow the user to print to 
printers in the same family, but with different parameters. 
 

File |Setup … Directories 

Selecting the tab marked Directories you will see following 
dialog box. 
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Graphic  
directory Enables the user the specify his own directory for graphic 
Label  
directory Enables the user the specify his own directory for labels. 

 

File |Setup … Colors 

Selecting the tab marked Colors you will see following 
dialog box. 

 

This dialog box enable users to change the appearance of 
the program when it comes to use other colors in the dialog 
boxes. 

File |Setup … Database 

Selecting the tab marked Database you will see following 
dialog box. 
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LabelCraft  
DDE Server  
Name This changes the DDE name pipe for LabelCraft. 
 NOTE! Any Changes here will result in that the programs 

ADBSERV.EXE and ODBCSERV.EXE will not be able to 
connect to the LabelCraft program. 

LabelCraft  
DDE Server  
Topic This changes the DDE topic name pipe for LabelCraft. 
 NOTE! Any Changes here will result in that the programs 

ADBSERV.EXE and ODBCSERV.EXE will not be able to 
connect to the LabelCraft program. 

Server  
program to be  
loaded  
automatically By entering a program name and path LabelCraft will start 

this program when you are setting a field to be receiving 
data from a database if such program is not yet started. 

 NOTE! If you are using another database / program and a 
DLL supplied by LabelCraft 
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(LABELIO.DLL/LABIO32.DLL) this text box should be 
left open. 

File |Setup … Format characters  

Selecting the tab marked Format characters you will see 
following dialog box. 

 
This dialog box enables the user to change the default 
format characters in LabelCraft. 

File | Formula Setup 

This menu options allows the user to modify the formula 
factors that are used in formulas. 
When you choose File | Formula Setup you see the 
following dialog box: 
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When you select a variable you will see the formula in the 
text box. If you want to modify this formula then change 
the content and press the button "OK".  
To add a new variable press the button "New Variable". 
You will now see a new dialog box: 

 

 
 

Enter the variable name in the Variable Name text box and 
the Formula in the Formula text box. Press the button "OK" 
to save the new variable. 
Formulas are enabled to handle formulas and calculations 
based on addition, subtraction, multiplication and division. 
Formulas are used in the Single line fields when using the 
option from other fields. See the section “Formulas” 
 
File | Redraw 
Use this menu option to refresh the ’Label Editor’ window. 
You can use F10 as a shortcut. 

File | Test Print 

Use this menu option to print just one label as a test. You 
can use F2 as a shortcut. 

 You can also click the print icon with the right mouse button 
to print a test label or right click in the editor window and 
select "Test print". 

File | Auto Num. Info: ‘Auto Num. Info’ dialog box 

Use this menu option to display printer status about the 
autonumbering fields on the label. 
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When you choose File | Autonum info, you see the ‘Auto 
Num. Info’ dialog box: 

 

 

File | Exit 

Choose this menu option to exit LabelCraft. 

Edit | Undo 

Use this menu option to undo the last operations. You can 
use Ctrl+Z as a shortcut or the icon . 

Edit | Redo 

Use this menu option to redo the last operations. You can 
use Ctrl+Y as a shortcut or the icon . 

Edit | Edit 

Use this menu option to edit the selected field. You can use 
Ctrl+R as a shortcut. 
When you choose Edit | Edit, you see a dialog box where 
you can change various field properties like font, text or 
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formatting codes. The layout of the dialog box depends on 
the type of field (text, rectangle, line etc.). 

Edit | Rotate field 1°: ‘Set field rotation’ dialog box 

Use this menu option to rotate the selected field in 1-degree 
steps. You can use Ctrl+M as a shortcut. 

 NOTE! You can also click the rotate icon with the right 
mouse button to activate this command. 

When you choose Edit | Rotate field 1°, you see the ‘Set 
field rotation’ dialog box: 

 

 
 

In this dialog box you specify the number of degrees you 
want to rotate the field. The rotation is always done 
clockwise. 
NOTE! You are only able to rotate TT-Font text fields and 
Bitmaps in this function. 

Edit | Rotate field 90° 

 Use this menu option to rotate the selected field 90 degrees. 
You can use Ctrl+T as a shortcut. 

The rotation is always done clockwise. 

Edit | Rotate label 90° 

Use this menu option to rotate the whole label 90 degrees. 
You can use Ctrl+A as a shortcut. 
The rotation is always done clockwise. 

Edit | Flip label 
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Use this menu option to flip the whole label (rotate it 180 
degrees). You can use Ctrl+U as a shortcut. 

Edit | Rotate ALL Fields 

Use this menu option to rotate all fields on the label 90 
degrees. The rotation is always done clockwise. 
 

Edit | Align 

Use this menu option to align fields relative to each other.  
When you choose Edit | Align, you see this sub-menu: 

 

 Align left edges 

 Align top edges 

 Align right edges 

 Align bottom edges 

 Align horizontal center 

 Align vertical center 
 

 

NOTE! All fields are aligned relative to the last field you 
selected. This field has black sizing handles. 

Edit | Align on Label 

Use this menu option to align the selected fields relative to 
the label borders.  
When you choose Edit | Align on Label, you see this sub-
menu: 
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 Align to the left side border of the label 

 Align to the top border of the label 

 Align to the right side border of the label  

 Align to the bottom of the label 

 Align to the horizontal center of the label 

 Align to the vertical center of the label 
 

Edit | Cut 

Use this menu option to cut the selected field and put it on 
the clipboard. You can use Ctrl+X as a shortcut. 
NOTE! Only LabelCraft are able to use the data that is put 
into the clipboard. 

Edit | Copy 

Use this menu option to copy the selected field to the 
clipboard. You can use Ctrl+C as a shortcut. 
NOTE! Only LabelCraft are able to use the data that is put 
into the clipboard. 

Edit | Paste 

Use this menu option to paste the content from the 
clipboard. You can use Ctrl+V as a shortcut. 
NOTE! Only LabelCraft are able to use the data that is put 
into the clipboard. 

Edit | Clear 
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Use this menu option to delete the selected field. You can 
use Del key on the keyboard as a shortcut. 

Edit | Copy Label 

Use this menu option to copy the whole label to the 
clipboard. You can use Ctrl+Q as a shortcut. The label will 
then be available as a bitmap for other program like MS 
Word. 

Edit | Copy Label, no frame 

Use this menu option to copy the whole label to the 
clipboard. The label will then be available as a bitmap for 
other program like MS Word. With this function no frame 
borders will be added to the bitmap image. 
 

Edit | Change Format: ’Edit label format’ dialog box 

Use this menu option to edit the label format. 
When you choose Edit | Change Format, you see the ‘Edit 
label format’ dialog box: 

 

 
 

Horizontal 
pitch 

If you want a horizontal gap between labels, type the gap 
plus the label width in this text box. 
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Vertical pitch If you want a vertical gap between labels, type the gap plus 
the label height in this text box. 

Label left 
origin 

If you want a gap from the left edge of the page to the left 
side of the first label column, type the gap in this text box. 

Label top 
origin 

If you want a gap from the top edge of the page to the top 
of the first label row, type the gap in this text box. 

No. empty 
labels 

Specify the number of labels to skip on the first page. This 
allows re-use of partial sheets of labels.  

Print speed Specify the print speed. This will only work on printers 
that support software temperature and speed settings. 

Print density Specify the print density. This will only work on printers 
that support software temperature and speed settings. 

 

Edit | Lock current Field 

Use this menu option to lock the current field for further 
editing. This field will now be disabled to further 
modifications. If this field is a database field, variable or 
linked to another field it will still be updated when 
printing. 
To confirm which of the fields that have been locked go 
into menu option 'View | Show Fieldborders'. The locked 
fields will be shown with a red border. 

 

Edit | Lock All Fields 

Use this menu option to lock all fields on the label for 
further editing. These fields will now be disabled to further 
modifications. If these fields are database fields, variable or 
linked to another field they will still be updated when 
printing. 
To confirm which of the fields that have been locked go 
into menu option 'View | Show Fieldborders'. The locked 
fields will be shown with a red border. 

Edit | Unlock All Fields 
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Use this menu option to unlock all fields on the label for 
editing. These fields will now be enabled to further 
modifications.  
If you need to unlock just one field, position the mouse 
cursor over the field and right click on the mouse. You will 
the see a button 'Unlock current Field'. Click on this button 
to unlock the current field. 
 
To confirm which of the fields that have been 
locked/unlocked go into menu option 'View | Show 
Fieldborders'. The locked fields will be shown with a red 
border. 
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Edit | Options: ‘Options’ dialog box 

Use this menu option to change the units of measurement 
or the password. 
When you choose Edit | Options, you see the ‘Options’ 
dialog box: 

 

 
 

Units Select the units of measurement; either mm or inch. 
 NOTE! If you have activated the ruler (View from the 

Show Ruler menu), you can press the button in the upper 
left corner of the ’Label Editor’ window to switch between 
mm and inch. 

 

 
 

Change  
password Press this button to change the password. You see the New 

password text box: 
 

 
 

NOTE! If a password is active, you must type your current 
password. 
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View | Show actual Size 

 Use this menu option to show the label in its actual size. 

View | Show All Label 

 Use this menu option to scale the label so that all of the label 
is shown on the screen. 

View | Zoom + 
 Use this menu option to zoom in on label or selected field. 

Left click on icon to zoom in 

View | Zoom - 
 Use this menu option to zoom out of the label or the 

selected field. Right click on icon to zoom out. 

View | Rotate label 90° 

Use this menu option to rotate the label 90 degrees. You 
can use Ctrl+W as a shortcut. 
The rotation is always done clockwise. 
NOTE! This rotation only affects the screen, not the 
printout. If you want to rotate the printed label, choose 
Rotate label 90° from the Edit menu. 

View | Flip label 

Use this menu option to flip the whole label (rotate it 180 
degrees). You can use Ctrl+E as a shortcut. 
NOTE! This only affects the screen, not the printout. If you 
want to flip the printed label, choose Flip label from the 
Edit menu. 

View | Remove rotation 
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Use this menu option to remove the rotation. You can use 
Ctrl+V as a shortcut. 
NOTE! This only removes the label rotation on the screen. 
To remove rotation on the printout, choose from the Edit 
menu. 

View | Show Coordinates 

 Use this menu option to show the coordinates of the mouse 
pointer. 

 
This makes it easier to position fields accurately. 

View | Show Crosshair 

 Use this menu option to show a crosshair to indicate the 
mouse position. 

This makes it easier to position fields accurately. 

View | Show Grid 

 Use this menu option to show the grid.  

This makes it easier to position fields accurately. 

View | Show Ruler 

 Use this menu option to show the horizontal and vertical 
ruler: 

 

This makes it easier to position fields accurately. 
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View | Show Fieldstatus 

 Use this menu option to show the status for the selected 
field: 

 
You will see the X and Y position, field Width and Height, 
Rotation, Field alignment and Font type. 

View | Show Fieldborder 

 Use this menu option to add a border around a field: 

 
This functions allows you to see the field borders for the 
defined fields on the label. In some cases you will 
experience that part of fields are overwritten by nearby 
fields. By using the menu option 'View | Show 
Fieldborder' you are able to reposition these fields to avoid 
such errors.  
When using locked fields these will be shown with a  red 
border.   

View | Command toolbar 

Use this menu option to show or hide the command 
toolbar: 
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NOTE! You can rearrange icons in the command toolbar 
from the Control menu. You can also place the toolbar 
under the menu line by selecting the option Dock  in 
the menu. If you want to undock the toolbar select the icon 

. 

View | View toolbar 

Use this menu option to show or hide the view toolbar: 
 

 
 

NOTE! You can rearrange icons in the view toolbar from 
the Control menu. You can also place the toolbar under the 
menu line by selecting the option Dock  in the 
menu.If you want to undock the toolbar select the icon 

. 
 

View | Save Screen Positions 

Use this menu option to enable the possibility to save 
screen positions when selecting “View | Save View 
modes” 

View | Save View Modes 

Use this menu option to save all the settings in the View 
menu. 

Field | Text: ‘Text Field’ dialog box 
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 Use this menu option to add a single-line text field to the 
label.  

 The single-line text field contains just one line of text. 

When you choose Field | Text, you see the ‘Text Field’ 
dialog box: 

 

 
 

Font If you want to use an internal printer font, select it from 
this menu. 

 NOTE! This menu is not shown when you have selected a 
generic Windows printer driver (PWIN). 

Style Use this menu to select the font style (for example Bold or 
Italic).  

 NOTE! This menu is only available for True Type fonts or 
with printer fonts that support styles. 

Expansion Use this menu option to specify text size (both width and 
height) and interspacing factor. For more information, see 
‘Text size factors’. 

TTfont If you want to use a True Type font, select it from this 
menu. For more information, see ‘Select Windows True 
Type font’. 
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Color If you want to use a color on the text, select the color from 
this menu. Color will only be available for printers that 
support colors or if the field has been setup as Preprinted. 

Dates If you want to use a special date select this button to enter 
the advanced date setting, see 'Advanced date'. 

Name Use this text box to name the field. Normally there is no 
need to name a field, but if you want to copy text from 
current field to another field you must enter a name. 

Fixed Select this option to create a fixed field. A fixed field 
always contains the same information, for example a 
company name. 

Variable Select this option to create a variable field. A variable field 
lets you specify what text to print each time you print the 
label. 

From other 
field 

Select this option to create a field that gets the text from 
another label field. You are also able to create formulas in 
this field. See “Formulas” for more info. 

Fixed field 
length 

Select this option to preserve formatting with start position 
and what characters that is extracted from the selected 
field. 

From database 
no 

Select this option to create a field that gets the text from an 
external data source; either the ASCII File Server or the 
ODBC Server. You must also specify what database to 
connect to (1, 2, 3 or 4). 

Field name If you have selected From other field or From database 
no, you must use this drop-down list to select the field 
from which to get the text. 

Start position If you want to remove leading characters from the data 
copied from another field, specify the start position here. 
This is useful if you want to use only a part of the copied 
data. 

Get data Click this button to fetch the first record from the data 
source. The data is added to the Content text box. 
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Alignment Select text alignment.  
NOTE! This option is not available for fixed fields or if 
you have selected Fit text into field. 

Inverse Select this option if you want LabelCraft to invert the field 
(that is, white becomes black and black becomes white). 

Fit text into 
field 

Select this option if you want the text to always fit into the 
field. When you resize the field, the text is automatically 
scaled. 

Size in points Select this option and specify the font size to set a fixed 
size for True Type fonts. This will also work with some 
internal printer fonts. 

 NOTE! When this option is active the field cannot be 
resized manually by using “drag and drop” technique. 

Disable 
printing 

Select this option if you want the field to be shown on the 
screen, but not printed. This function are often used when 
making calculation or merging fields together and when 
you only want to see the result. 

Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 

Preprinted This will present a field on screen that will not be printed. 
This field can be modified to be shown in color even thou 
the printer will not support colors. To lock the filed from 
being moved or changed select "Locked" as well.  
Please see the section Preprinted fields fields. 

Auto 
Underline 6 & 
9  

This function is only applicable with TT-fonts. The 
numbers 6 and 9 will be printed with underline to stop 
misinterpretations.   

Format In this text box you specify the formatting codes. For more 
information, see ‘Formatting codes’. 

Content Type the text to be printed in this text box. 

 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 83

Field | Multi-line text: ‘Multi line textfield’ dialog box 

 Use this menu option to add a multi-line text field to the 
label. 

 The multi-line text field can contain several lines of text. 
This field is very useful for addresses. 

When you choose Field | Multi-line text, you see the ‘Multi 
line textfield’ dialog box: 

 

 
 

Font If you want to use an internal printer font, select it from 
this menu. 
NOTE! This menu is not shown when you have selected a 
generic Windows printer driver (PWIN). 

Style Use this menu to select the font style (for example Bold or 
Italic).  

 NOTE! This menu is only available for True Type fonts. 

Expansion Use this menu option to specify text size (both width and 
height) and interspacing factor. For more information, see 
‘Text size factors’. 

TTfont If you want to use a True Type font, select it from this 
menu. For more information, see ‘Select Windows True 
Type font’. 
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Field name Use this text box to name the field. Normally there is no 
need to name a field, but if you want to copy text from 
another field you must give this field a name. 

Fixed Select this option to create a fixed field. A fixed field 
always contains the same information, for example a 
company name. 

From  database Select this option to create a field that gets the text from an 
external data source; either the ASCII File Server or the 
ODBC Server. 

Import textfile Press this button to import a text file. You see the ‘Open’ 
dialog box. Select the file you want to import and click 
OK. The content of the file is added to the Content text 
box. 

Database setup Press this button to specify information about the database 
connection. For more information, see ‘Multi text database 
setup’. 

Disable 
printing 

Select this option if you want the field to be shown on the 
screen, but not printed. 

Inverse Select this option if you want LabelCraft to invert the field 
(that is, white becomes black and black becomes white). 

TAB positions In this box you set the tabulators. To set a tabulator, 
simply click on the desired position on the dotted line. A 
‘t’ appears on the line to indicate the tabulator position. 
Click on the ‘t’ again to remove it. 
NOTE! When the cursor is in the Content text box you 
press Ctrl+I to insert a tabulator stop. 

Size in points Select this option and specify the font size to set a fixed 
size for True Type fonts. This will also work with some 
internal printer fonts. 
NOTE! When this option is active the field cannot be 
resized manually. 
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Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 

Preprinted This will present a field on screen that will not be printed. 
This field can be modified to be shown in color even thou 
the printer will not support colors. To lock the filed from 
being moved or changed select "Locked" as well.  
Please see the section Preprinted fields fields. 

Line spacing Specify the distance between text lines, measured from the 
top of a line to the top of the next line. 

Alignment Select text alignment.  
NOTE! Internal printer fonts cannot be right justified. 

Content Type the text in this text box. 
Press Ctrl+I to insert a tabulator stop. 

 

Field | Barcode: ‘Bar Code’ dialog box 

 Use this menu option to add a barcode field to the label.  

 LabelCraft can handle several barcode types. If the printer 
cannot print the code from its internal code generator, 
LabelCraft can print the barcode as graphics. This may, 
however, be slower. 
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Type From this menu you select the barcode type. 

 NOTE! If one or more of the code types are shown in gray, 
the printer cannot print this code from its internal code 
generator. If so, check Print as bitmap below. 

Ratio Use this menu to select the ratio. 

Width Use this menu to select the width of the barcode. 

Color If you want to use a color on the text, select the color from 
this menu. 

Dates If you want to use a special date select this button to enter 
the advanced date setting, see 'Advanced date'. 

Name Use this text box to name the field. Normally there is no 
need to name a field, but if you want to copy data from 
another field you must give this field a name. 

Fixed Select this option to create a fixed field. A fixed field 
always contains the same information. 

Variable Select this option to create a variable field. A variable field 
lets you specify the barcode data each time you print the 
label. 

From other 
field 

Select this option to create a field that gets the barcode 
data from another label field. 
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From db no Select this option to create a field that gets the barcode 
data from an external data source; either the ASCII File 
Server or the ODBC Server. Specify what database to 
connect to (1, 2, 3 or 4).. 

Field name If you have selected From other field or From database 
no, you must use this drop-down list to select the field 
from which to get the barcode data. 

Start position If you want to remove leading characters from the data 
copied from another field, type the start position here. This 
is useful if you want to use only a part of the copied data. 

Get data Click this button to fetch the first record from the data 
source. The data is added to the Content text box. 

HIBC This function will only be shown if the barcode is 
supported in the HIBC standard. For further information 
see Part 5: HIBC Barcode. 

Human 
readable. 

Select this option if you want the label to show the barcode 
in numerals. 

Check digit Select this option if you want to activate ‘check digit’ 
calculation. If an error occurs you see this dialog box: 

 
 

 
 

Quiet zones Check this to add quiet zones to the barcode. 
Disable 
printing 

Select this option if you want the field to be shown on the 
screen, but not printed. 

Print as bitmap If the printer cannot print the barcode from its internal 
code generator, select this option to let LabelCraft print the 
barcode as graphics. This may, however, be slower. 

Advanced Click this button to specify advanced settings. Advanced 
settings can only be set on barcodes UPC, EAN 128 and 
MSI. For more information, see ‘Advanced barcode 
settings’. 

Height Specify the height of the barcode. 
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Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 

Preprinted This will present a field on screen that will not be printed. 
This field can be modified to be shown in color even thou 
the printer will not support colors. To lock the filed from 
being moved or changed select "Locked" as well.  
Please see the section Preprinted fields. 

Format In this text box you specify the formatting codes. For more 
information, see 'Formatting codes'. 
NOTE! UPC, EAN and ITF codes are automatically 
formatted with ‘^’. 

Content In this text box you specify the barcode data. 

  

Field | Graphic: ‘Graphic field’ dialog box 

 Use this menu option to add an image to the label.  

 LabelCraft can handle graphics in *.BMP, *.PCX, *.MSP, 
*.WMF, *.JPG, *.JIF and *.GIF formats. You can scale 
graphics to any size. 

 

 
 

Name Use this text box to name the field. Normally there is no 
need to name a field, but if you want to copy data from 
another field you must give this field a name. 
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Fixed Select this option to create a fixed field. A fixed field 
always contains the same image. 

From  database 
no 

Select this option to create a graphic field that gets the file 
name of the image from an external data source; either the 
ASCII File Server or the ODBC Server. You must also 
specify what database to connect to (1, 2, 3 or 4). 

Field name If you have selected From database no, you must use this 
drop-down list to select the field to get the file name from. 

Graphic file This text box displays the name of the graphic file. 

Get data Click this button to fetch the file name for the first record 
from the data source. The file name is added to the 
Graphic file text box 

Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 

Preprinted This will present a field on screen that will not be printed. 
This field can be modified to be shown in color even thou 
the printer will not support colors. To lock the filed from 
being moved or changed select "Locked" as well.  
Please see the section Preprinted fields. 

Disable 
printing 

Select this option if you want the field to be shown on the 
screen, but not printed. 

Import image Click this button to import an image from a file. You see 
the ‘Open’ dialog box. Select the file you want to import 
and click OK. The image is added to the label. 

Paste Click this button to add the image on the clipboard to the 
label. 

Color If you want to use a color on the image, select the color 
from this menu. 
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Field | Autonum text: ‘Auto-Numbering Text’ dialog box 

 Use this menu option to add an autonumbering text field to 
the label. 

 An autonumbering text field is a text field that 
automatically generates ascending or descending numbers 
when the label is printed. 

NOTE! Choose Auto. Num Info from the File menu to 
display printer status about the autonumbering fields on 
the label. 
When you choose Field | Autonum text, you see the ‘Auto-
Numbering Text’ dialog box:  

 

 
 

Font If you want to use an internal printer font, select it from 
this menu. 

 NOTE! This menu is not shown when you have selected a 
generic Windows printer driver (PWIN). 

Style Use this menu to select the font style (for example Bold or 
Italic).  

 NOTE! This menu is only available for True Type fonts. 

Expansion Use this menu option to specify text size (both width and 
height) and interspacing factor. For more information, see 
‘Text size factors’. 
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TTfont If you want to use a True Type font, select it from this 
menu. For more information, see ‘Select Windows True 
Type font’. 

Name Use this text box to name the field. Normally there is no 
need to name a field, but if you want to copy text from 
another field you must give this field a name. 

Fixed Select this option to create a fixed field. A fixed field 
always contains the same start number. 

 NOTE! If you select Update file, the start number is 
automatically updated each time you print the label. 

Variable Select this option to create a variable field. A variable field 
lets you specify the start number each time you print the 
label. 

Update file Select this option to automatically store the last number 
that was printed. This means that the Content text box is 
automatically updated after the printing is finished. 

 This is very useful if you want to keep a record of the 
number of labels printed. Check Disable printing, and the 
number of printed labels appears on the screen, but not on 
the printout! 

Group size Specify the group size. The result depends on whether you 
select Batch or Group. 
Here is an example that explains the difference. You 
choose 3 as group size, start at 1, increment by 1 and print 
9 labels: 

- If you select Batch, LabelCraft generates the following 
numbers: 1 1 1 2 2 2 3 3 3. 

- If you select Group, LabelCraft generates the following 
numbers: 1 2 3 1 2 3 1 2 3. 

Batch Select this option if you want to use the group size as the 
number of each value to print. For example 1 1 1 2 2 2 3 3 
3. 
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Group Select this option if you want to print each value once, 
then start again at the beginning of the sequence. The 
group size specifies the size of the sequence. For example 1 
2 3 1 2 3 1 2 3. 
NOTE! Not all printers support repeating groups. If you 
select this option and the printer cannot support it, 
LabelCraft takes control and does the numbering. This is 
slower since the printer has to be continuously updated. 

Step size Specify the number to increment or decrement the value 
for each label printed. 

 For example, if you specify 1 LabelCraft prints 1, 2, 3, 4 
and so on. If you specify 3 LabelCraft prints 1, 4, 7, 10 and 
so on. 

Up Select this option if you want LabelCraft to generate the 
numbers in ascending order. 

Down Select this option if you want LabelCraft to generate the 
numbers in descending order. 

Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 

Underline 6 & 
9 

Use this function to underline the numbers 6 and 9.  
NOTE! This function is only supported with TT-fonts. 

Suppress 
leading zeros 

Select this option is you want to suppress leading zeros. 
NOTE! Not all printers can do this. 

Disable 
printing 

Select this option if you want the field to be shown on the 
screen, but not printed. 

Inverse Select this option if you want LabelCraft to invert the field 
(that is, white becomes black and black becomes white). 

Color If you want to use a color on the text, select the color from 
this menu. 

Size in points Select this option and specify the font size to set a fixed 
size for True Type fonts. This will also work with some 
internal printer fonts. 
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 NOTE! When this option is active the field cannot be 
resized manually. 

Format This field must contain the symbol ‘^’ (hold down ALT 
while you type 0094 on the numeric keyboard to generate 
a ‘^’).  

 The number of ‘^’s sets the maximum number of digits in 
the number. For example, if you specify ‘^^^’, the 
maximum number if 999. 

Content Type the start number in this text box. 

 

Field | Autonum barcode: ‘Auto-Numbering barcode’ 
dialog box 

 Use this menu option to add an autonumbering barcode 
field to the label. 

 The autonumbering barcode field is similar to the auto-
numbering text field, except that the generated number is 
used to create a barcode. 

When you choose Field | Autonum barcode, you see the 
‘Auto-Numbering barcode’ dialog box:  
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Type From this menu you select the barcode type. 
NOTE! If one or more of the code types are shown in gray, 
the printer cannot print this code from its internal code 
generator. If so, check Print as bitmap below. 

Ratio Use this menu to select the ratio. 

Width Use this menu to select the width of the barcode. 

Name Use this text box to name the field. Normally there is no 
need to name a field, but if you want to copy data from 
another field you must give this field a name. 

Fixed Select this option to create a fixed field. A fixed field 
always contains the same start number. 
NOTE! If you select Update file, the start number is 
automatically updated each time you print the label. 

Variable Select this option to create a variable field. A variable field 
lets you specify the start number each time you print the 
label. 

Update file Select this option to automatically store the last number 
that was printed. This means that the Content text box is 
automatically updated after the printing is finished. 

Group size Specify the group size. The result depends on whether you 
select Batch or Group. 

 Here is an example that explains the difference. You 
choose 3 as group size, start at 1, increment by 1 and print 
9 labels: 

- If you select Batch, LabelCraft generates the following 
numbers: 1 1 1 2 2 2 3 3 3. 

- If you select Group, LabelCraft generates the following 
numbers: 1 2 3 1 2 3 1 2 3. 

Batch Select this option if you want to use the group size as the 
number of each value to print. For example 1 1 1 2 2 2 3 3 
3. 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 95

Group Select this option if you want to print each value once, 
then start again at the beginning of the sequence. The 
group size specifies the size of the sequence. For example 1 
2 3 1 2 3 1 2 3. 
NOTE! Not all printers support repeating groups. If you 
select this option and the printer cannot support it, 
LabelCraft takes control and does the numbering. This is 
slower since the printer has to be continuously updated. 

Step size Specify the number to increment or decrement the value 
for each label printed.  
For example, if you specify 1 LabelCraft prints 1, 2, 3, 4 
and so on. If you specify 3 LabelCraft prints 1, 4, 7, 10 and 
so on. 

Up Select this option if you want LabelCraft to generate the 
numbers in ascending order. 

Down Select this option if you want LabelCraft to generate the 
numbers in descending order. 

Height Specify the height of the barcode. 

Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 

Disable 
printing 

Select this option if you want the field to be shown on the 
screen, but not printed. 

Check digit Select this option if you want to activate ‘check digit’ 
calculation. If an error occurs you see this dialog box: 
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Human 
readable 

Select this option if you want the label to show the barcode 
in numerals. 

Quiet zones Check this to add quiet zones to the barcode. 

Print as bitmap If the printer cannot print the barcode from its internal 
code generator, select this option to let LabelCraft print the 
barcode as graphics. This may, however, be slower. 

Advanced Click this button to specify advanced settings. Advanced 
settings can only be set on barcodes UPC, EAN 128 and 
MSI. For more information, see ‘Advanced barcode 
settings’. 

Color If you want to use a color on the barcode, select the color 
from this menu. 

Format This field must contain the symbol ‘^’ (hold down ALT 
while you type 0094 on the numeric keyboard to generate 
a ‘^’).  

 The number of ‘^’s sets the maximum number of digits in 
the number. For example, if you specify ‘^^^’, the 
maximum number if 999. 

Content In this text box you type the start number. 

 
Field | Rectangle: ‘Rectangle’ dialog box 

 Use this menu option to add a rectangle to the label.  

 The rectangle can be scaled in all directions. 
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Name Use this text box to name the rectangle. 

Color If you want to use a color on the text, select the color from 
this menu. 

Line width In this text box you specify the width of the line used to 
draw the rectangle. 

Rect. width In this text box you specify the width of the rectangle. 

 NOTE! It is quicker to scale the rectangle by dragging after 
you have added it to the label. 

Rect. height In this text box you specify the height of the rectangle. 

 NOTE! It is quicker to scale the rectangle by dragging after 
you have added it to the label. 

Line type Specify the type of line. This option will, for the moment, 
only work for some printers. 

Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 

Preprinted This will present a field on screen that will not be printed. 
This field can be modified to be shown in color even thou 
the printer will not support colors. To lock the filed from 
being moved or changed select "Locked" as well.  
Please see the section Preprinted fields fields. 

Disable 
printing 

Select this option if you want the rectangle to be shown on 
the screen, but not printed. 

Select by... Select this option if you want to use the right mouse button 
to select the rectangle instead. You still have to use the left 
mouse button to move or resize the rectangle. 

 This feature is very useful if you have a big rectangle 
width many fields inside. By activating this feature you 
can prevent unwanted movement of the rectangle when 
editing the fields inside it. 
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Field | Line: ‘Line’ dialog box 

 Use this menu option to add a line to the label.  

 You can easily change the width and length of the line. 

When you choose Field | Line, you see the ‘Line’ dialog 
box:  

 

 
 

Name Use this text box to name the line. 

Color If you want to use a color on the text, select the color from 
this menu. 

Line width In this text box you specify the width of the line. 

 NOTE! It is quicker to scale the line by dragging after you 
have added it to the label. 

Line length In this text box you specify the length of the line. 

 NOTE! It is quicker to scale the line by dragging after you 
have added it to the label. 

Line type Specify the type of line. This option will, for the moment, 
only work for some printers. 

Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 
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Preprinted This will present a field on screen that will not be printed. 
This field can be modified to be shown in color even thou 
the printer will not support colors. To lock the filed from 
being moved or changed select "Locked" as well.  
Please see the section Preprinted fields fields. 

Disable print Select this option if you want the field to be shown on the 
screen, but not printed. 

 

Field | Circle; ‘Circle’ dialog box 

 Use this menu option to add a circle to the label.  

 You can easily change the width and length of the circle. 

When you choose Field | Circle, you see the ‘Circle’ dialog 
box:  

 
  
 

Name Use this text box to name the line. 

Color If you want to use a color on the text, select the 
color from this menu. Note! Only shown when 
printer supports color. 

Line width In this text box you specify the width of the line. 

Circle radius In this text box you specify the radius of the 
circle. 
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Circle vert. 
radius 

In this text box you specify the height of the 
circle. 

 NOTE! It is quicker to scale the rectangle by 
dragging after you have added it to the label. 

Filled circle Make the circle to be filled. If printer supports 
color you are able to select a color on the fill. 

Line type If printer supports this line type can be selected. 

Locked This will lock the field from further editing. You 
will not be able to change or move this field after 
pressing the button OK.  
Please see the section Locking fields. 

Preprinted This will present a field on screen that will not be 
printed. This field can be modified to be shown in 
color even thou the printer will not support 
colors. To lock the filed from being moved or 
changed select "Locked" as well.  
Please see the section Preprinted fields fields. 

Disable print Select this option if you want the field to be 
shown on the screen, but not printed. 

Select by... Select this option if you want to use the right 
mouse button to select the rectangle instead. You 
still have to use the left mouse button to move or 
resize the rectangle. 
This feature is very useful if you have a big 
rectangle width many fields inside. By activating 
this feature you can prevent unwanted 
movement of the circle when editing the fields 
inside it. 

 
Field | PDF 417 ‘PDF417’ dialog box 
 
PDF-417 is a 2 dimensional code which is accessible by 
menu selection Field|PDF-417. When you choose Field | 
PDF 417, you see the ‘PDF417’ dialog box: 
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Field name Use this text box to name the field. Normally there is no 
need to name a field, but if you want to copy text from 
another field you must give this field a name. 

Fixed Select this option to create a fixed field. A fixed field 
always contains the same information, for example a 
company name. 

From database Select this option to create a field that gets the text from an 
external data source; either the ASCII File Server or the 
ODBC Server. 

Import textfile Press this button to import a text file. You see the ‘Open’ 
dialog box. Select the file you want to import and click 
OK. The content of the file is added to the Content text 
box. 

Database setup Press this button to specify information about the database 
connection. For more information, see ‘Multi text database 
setup’. 

Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 
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Preprinted This will present a field on screen that will not be printed. 
This field can be modified to be shown in color even thou 
the printer will not support colors. To lock the filed from 
being moved or changed select "Locked" as well.  
Please see the section Preprinted fields. 

Print as Bitmap When this option is selected the barcode will be printed as 
a bitmap. 

Disable 
printing 

Select this option if you want the field to be shown on the 
screen, but not printed. 

Module Width In this text box you specify the width of the module. 

No. Rows In this text box you specify the No. of rows to use. You can 
set the No. of rows between 3 and 90. 

Height In this text box you specify the height in dots for each row. 

Error 
Correction 

In this text box you specify the No. error correction to use. 

Info Selecting this button will give you an info about the 
symbol. 

Structured 
Data File 

When selecting this option the data from the PDF will be 
presented as data content for a structured data file for EDI. 

 
 
 

Field | Datamatrix ‘Datamatrix’ dialog box 
 
Datamatrix is a 2 dimensional code which is accessible by 
menu selection Field|Datamatrix…. When you choose 
Field | Datamatrix…, you see the ‘Datamatrix’ dialog box: 
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Field name Use this text box to name the field. Normally there is no 
need to name a field, but if you want to copy text from 
another field you must give this field a name. 

Fixed Select this option to create a fixed field. A fixed field 
always contains the same information, for example a 
company name. 

From database Select this option to create a field that gets the text from an 
external data source; either the ASCII File Server or the 
ODBC Server. 

Import textfile Press this button to import a text file. You see the ‘Open’ 
dialog box. Select the file you want to import and click 
OK. The content of the file is added to the Content text 
box. 

Database setup Press this button to specify information about the database 
connection. For more information, see ‘Multi text database 
setup’. 

Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 

Preprinted This will present a field on screen that will not be printed. 
This field can be modified to be shown in color even thou 
the printer will not support colors. To lock the filed from 
being moved or changed select "Locked" as well.  
Please see the section Preprinted fields. 

Print as Bitmap When this option is selected the barcode will be printed as 
a bitmap. 

Disable 
printing 

Select this option if you want the field to be shown on the 
screen, but not printed. 

Module Width In this text box you specify the width of the module in 
pixels. 

Structured 
Data 

When selecting this option the data from the code will be 
presented as data content for a structured data file for EDI. 
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Info Selecting this button will give you an info about the 
symbol. 

 

Field | Codablock barcode ‘Codablock 2-dimensional 
Code’ dialog box 

 
Codablock is a stacked barcode (2-dimensions) which is 
accessible by menu selection Field | Codablock barcode.  
When you choose Field | Codablock… barcode, you see 
the ‘Codablock 2-dimensional Code’ dialog box. 

 

 
 

Field name Use this text box to name the field. Normally there is no 
need to name a field, but if you want to copy text from 
another field you must give this field a name. 

Fixed Select this option to create a fixed field. A fixed field 
always contains the same information, for example a 
company name. 

From database Select this option to create a field that gets the text from an 
external data source; either the ASCII File Server or the 
ODBC Server. 
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Import textfile Press this button to import a text file. You see the ‘Open’ 
dialog box. Select the file you want to import and click OK. 
The content of the file is added to the Content text box. 

Database 
setup 

Press this button to specify information about the database 
connection. For more information, see ‘Multi text database 
setup’. 

Module Width In this text box you specify the width of the module. 

Symbols pr. 
row 

In this text box you specify the No. of symbols pr. row. 

Row height In this text box you specify the height in mm for each row. 

Row separator 
thickness 

Set the thickness of the row separator 

EAN/UCC Specifies if the code is to be used as an EAN/UCC 
encoding. 

Info Selecting this button will give you an info about the 
symbol. 

Structured 
Data 

Selecting this option will implement formatting into the 
barcode in such way as it confirm to EDI spec. 

Ignore line 
breaks 

This will ignore line breaks in the content text box when 
adding data into the barcode. 

Locked This will lock the field from further editing. You will not 
be able to change or move this field after pressing the 
button OK.  
Please see the section Locking fields. 

Preprinted This will present a field on screen that will not be printed. 
This field can be modified to be shown in color even thou 
the printer will not support colors. To lock the filed from 
being moved or changed select "Locked" as well.  
Please see the section Preprinted fields. 

Disable 
printing 

Select this option if you want the field to be shown on the 
screen, but not printed. 

Print as 
Bitmap 

The barcode will be sent to the printer as a Bitmap 
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HIBCC This will add a new button for using the HIBCC encoding 
to the barcode. For more info see Part 5: HIBCC barcode. 

 
 

Print 

Use this menu option to print the label.  
This is the same command as File | Print. For more 
information, see ‘File | Print’. 

Redraw 

Use this menu option to refresh the ’Label Editor’ window. 
This is the same command as File | Redraw. For more 
information, see ‘File | Redraw’. 

Test Print 

Use this menu option to print just one label as a test.  
This is the same command as File | Test Print. For more 
information, see ‘File | Test Print’. 

Help | About 

Use this menu option to show the ’About LabelCraft’ 
dialog box. This dialog box contains information about 
LabelCraft, for example the version number, version date 
and copyright. 
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Help | View parameters: ‘View parameters’ dialog box 

Use this menu option to show the dialog box ‘View 
parameters’. 
This dialog box gives you information about the various 
startup parameters you can give LabelCraft. These 
parameters correspond to the commands in the View 
menu.  

 

 

‘Label database information’ 

 You activate the ‘Label database information’ dialog box by 
clicking Database info in the ‘New label’ dialog box. 
In this dialog box you specify the data source for fields that 
get their data from an external data source (either the 
ASCII File Server or the ODBC Server). 
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You may define up to four different database servers. You 
must specify the name of the data source (for example 
ODBCServ or LabelServer) and the topic name of the 
connection (for example LabelData). 
If you need more information, see ‘ASCII File Server’ and 
‘ODBC2000 Server’. 

‘Printer dependent label parameters’ 

The Printer dependent label parameters dialog box is 
activated by clicking Extra info in the ‘New label’ dialog 
box. 
The contents of this dialog box may vary from printer to 
printer. Click on Driver Info for important information 
about the printer driver setup. 
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Extra datafile sent with label enables the usage of sending a 
shift label to the printer. This datafile will be sent to the 
printer before the label itself will be printed. 

Text size factors 

For all text fields you can set the text size factors. You do 
this by clicking Expansion on the menu-bar in the text field 
dialog box. The dialog box you see depends on whether 
you have selected a True Type font or an internal printer 
font. 
True Type font 

 

 
 

Font width Specify the font width, in either millimeters or inches. 

Font height Specify the font height, in either millimeters or inches. 

Interspacing Specify the interspacing (space between characters), in 
either millimeters or inches. You are able to reduce the 
width between each character when using a negative 
value. 

Standard 
values 

These lists show the standard values. 
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Internal printer font 
 

 
 

Width factor Specify the width in a multiple of the basic font size. 

Height factor Specify the height in a multiple of the basic font size. 

Interspacing 
factor 

Specify the interspacing (space between characters), in a 
multiple of the basic font. 
 
NOTE! Internal printer fonts might look bad when they 
are enlarged. 

‘Select Windows True Type font’ 

To select a True Type font, click TTfont on the menu-bar in 
the text field dialog box. Then select the True Type font 
you want to use from the drop-down list in the ‘Select 
Windows True Type Font’ dialog box: 
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‘Multi text database setup’ 

When you press the Database setup button in the dialog 
box ’Multi line textfield’ you see the dialog box ‘Multi Text 
Database Setup’: 

 

 
 

From Database 
no 

Specify the database number to connect to. 

Database field 
name 

Select the field to read data from. 

Get data Click this button to fetch the first record from the data 
source. The data is added to the Text file text box. 

Text file This text box shows the data from the first record. 

No. of 
paragraphs 

Specify the number of paragraphs to include. 

No. of 
paragraphs to 
skip 

Specify the number of paragraphs to skip. 

Limit no. of line 
characters 

Select this option to limit the number of characters pr. 
line. 

Max. no. of 
characters pr. 
line 

Specify the maximum number of characters pr. line. 

Format entire 
paragraph 

Select this option to format the entire paragraph. 

ANSI coding Select this option if the data is ANSI coded. 
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DB field is data Select this option if the field contains actual data you 
want to print. If not, LabelCraft treats the field contents 
as the name of the file to print. 

 

Advanced barcode settings 

This section describe special settings for UPC, MSI and 
EAN 128 barcodes. You activate this dialog box by pressing 
the Advanced button in the ‘Bar Code’ dialog box.  
Not all printers can support this option. LabelCraft can 
always support this feature when you have selected Print 
as bitmap. LabelCraft then generates the barcode, not the 
printer. 
The dialog box you see depends on the type of barcode. 
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The print module 

To start the print module, choose Label Printing in the 
main window. 

 

 
 

File Use this menu option to open an existing label, change 
language or open one of the last labels (4) used. 

Print Use this menu option to print the label. This activates the 
‘Print Options’ dialog box. For more information, see ‘File 
| Print’. 

Stop print Use this menu option to stop the print job. This option is 
shown in Grey until printing is started. 

Stop print Use this menu option to stop the print job. This option is 
shown in Grey until printing is started. 

Redraw Use this menu option redraw the label on screen. 
View Use the menu options in this menu to rotate or flip the 

label. 
About Use this menu option to show the ‘About LabelCraft’ 

dialog box. This dialog box contains information about 
LabelCraft, for example the version number, version date 
and copyright. 
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The setup module 

Before you can start using LabelCraft, you must configure 
your printer(s). You can define up to four different printers 
that you can choose between when you want to print labels. 
To start the setup module, either click Setup in the ‘New 
label’ dialog box or start LSETUP.EXE that was copied to 
the program directory during installation. You see the 
‘Label Setup’ window: 

 

 
 

Filename Type the name of the file that the configuration is saved in. 
You may change this if you need more than one printer 
configuration. If not, we recommend that you do not 
change the filename. 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 117

Output port To set-up what output port to be using click on the button 
“Edit”. A dialog box will now be opened: 

 
Select with a radio button what port type to use. Each port 
type will have a corresponding dialog. Com port and 
Parallel port will look like the one that is shown above. 

 TCP/IP port: 

 
TCP/IP connection is done by RAW TCP/IP format. 
When using TCP/IP make sure that your system will 
support this format. Make sure that the “Local Port” is set-
up correct. 
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 Network resource: 

 
When using a network-shared resource this needs to be 
identified correct. Computer name is the network name for 
the computer that is sharing out his port. Shared port 
resource is the name you have setup in the printer driver. 
Note! To use this function you must have enabled the 
system to share out its printers. On the example above we 
have setup the server on the system to share out a resource 
that is controlled by the server. In this example, it could 
have been a local printer port. There has been installed a 
printer driver that is assign to the port that you will 
connect the printer to. A note of caution, please use a 
simple driver as possible (Example: Generic Text only). 
When you are setting up the spooler setting of this driver 
make sure that you have setup the data format to be RAW. 
Other formats may generate extra characters to be sent to 
the printer that may result in damaged output by the 
printer. 
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 File/other: 

 
When you want to print to a file or using an USB device 
this is the port setting you are going to use. For printing to 
a file just insert the name of the file that that you want to 
generate. If you are going to use an USB port enter the port 
name in this text box (example: USB001). 

Printer Select the printer driver to use.  

 If you want to use a generic Windows printer driver, select 
PWIN. LabelCraft then uses the default printer from the 
Windows Control Panel (unless you select NODEF from 
the Parameters list - you are then prompted for printer 
before printing is started). 

Parameters Select you printer model and specify other printer 
parameters. This will vary from printer to printer. 

Info Click this button for more information about the various 
parameters. 

Character table Specify the internal printer character table to use. 

 NOTE! Click on the Info button, then Character codes or 
Country codes for a list of the character tables. 

Version Displays the software version. 

Custom 
module 

Specify a special software module, if any. 

Load Press this button to use another label setup. You type the 
file name in the text box Filename. 

Save Press this button to save the label setup. You type the file 
name in the text box Filename. 

Quit Press this button to close the window. 
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Advanced date functions 

LabelCraft is equipped with an advanced date function 
that enables the user to create his own special dates, which 
could contain shift info, day names, month names own 
special month names and a lot of other possibilities. 
To use the advanced date function select Field | Text or 
Field | Barcode and press the button 'Dates'. Following 
dialog box will then appear: 

 
Setup Selecting Setup on the menu line enables the user to 

setup shift codes and start/end time of shift, date 
change time and to set Sunday or Monday as first 
day of week. 

Available Auto- 
codes 

The user must select what date function that is to be 
used. To select an auto-code double click the auto-
code or click and push the button 'Append' or 
'Insert' to add the auto-code. 
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Text By entering text into the box and push the button 
'App. text' or 'Ins. text' one are able to insert own 
special text into this date function. 

Property This function enables the change of some of the 
auto-codes. 

Delete Deletes the selected auto-code. 

Info This box gives a short description of what the auto-
code will deliver. 

Example Gives an example of what the auto-code will show 
on the label. 

LabelCraft 
format 

Gives the format string for the current selection of 
auto-codes. 

 
Changes of properties are available for following codes: 
Year 

 
 

Month name 

 
For selection of moth name in another language or own 
special version select language. For making an own month 
spelling select the button 'Own month spelling'. 
Month name and day name properties are equal in the 
setting of properties. 
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When a date code is set up like this 'Date(1)' it means that 
date that contains only one digit will be shown with only 
one digit. 

Formulas 

LabelCraft allows you to calculate content of fields with 
contents of variables that has been added with the function 
" File |Formula Setup". At current this function has only 
been implemented with multiplication, but others will soon 
be available. 

How to use formulas. 

Make a new field, or an existing, but give the field a name. 
See picture below: 

 

 
 

This text field has been named 'NOK'. We have made the 
field to be variable. In the content text box we have entered 
the number '100.00'. This will also give the format to the 
result of the formula. If you want 2 decimals in the answer 
you must use 2 decimals in the field where your number 
are originated.  
Next step is to use this field to generate a new value based 
on the setting in Formula. Select menu option  
"File | Text …'. Then push the radio button  ~ 'From other 
field'. Select field name NOK. Add * after the field name 
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and add the formula you want to use. In my example we 
are using the statement: "NOK*$USD".  

 

 
 

Please note that the field name contains the statement: 
"NOK*$USD". You will also see that a lot of stars has been 
added into text box 'Format:'. The Content text box is 
showing the value based on the calculation from formula. 
If you want to make a new calculation based on the current 
one you must name this field to have it available to do 
another calculation.  

 

  
 

Above are two labels that has been made by changing the 
value of the variable field named NOK all fields based on 
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this value has now been changed. In order to have the 
fields looking good on printout we also made the fields to 
be right justified. 

Formatting codes 

LabelCraft lets you use formatting codes to limit the 
content of text and barcode fields. This is very useful for 
variable fields that accept data each time you print the 
label.  
Text format special characters 
_ Accept any character 
* Accept any character from other field 
\ Accept letters and digits only 
| Convert to capital letters 
~ Accept digits and ± 
^ Accept digits only 

 
 

You can also use formatting codes to add special date and 
time fields in text fields. 
Special fields in text fields 
<<d Start date/time field 
>> end of special field 

 

Examples: 
 <<dDD/MM-19YY  hh:mm>> (06/12-1996  15:58) 
 <<dYY/MM/DD  hh.mm>> (96/12/06  15.58) 
 <<dYY/MM/DD+30  hh:mm:ss>> (97/01/05  15:58:53) 
 
 
Special field codes in Code 128 barcode fields. 
 
F1 FNC1 or <Alt>+<0170> 
F2 FNC2 or <Alt>+<0171> 
F3 FNC3 or <Alt>+<0172> 
F4 FNC4 or <Alt>+<0174> 
F5 Shift  or <Alt>+<0175> 
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F6 CodeA or <Alt>+<0176> 
F7 CodeB or <Alt>+<0177> 
F8 CodeC or <Alt>+<0178> 
F9 StartA or <Alt>+<0185> 
F10 StartB or <Alt>+<0186>  
F11 StartC or <Alt>+<0187> 
F12 Take next  or <Alt>+<0188> 

charachter  
literally 
 

NOTE! If you are going to enter a format code in the text 
box 'Format:' to make a Code128 barcode containing 
special format codes, you must hold down the Alt key 
while entering the corresponding number on numerical 
keypad. Some PC's demand a full size keyboard to do this. 

Locked fields 

LabelCraft allows the user to lock a field for further editing. 
You will not be able to move or change this field, unless 
you unlock the field. If the field is connected to a database 
or another field the data content of it will be  updated 
when the origin changes. 
To unlock previously locked fields you can do this from the 
menu selection "Edit | Unlock all Fields". This option will 
unlock all fields. If the you need to unlock just on field 
position the mouse pointer on top of the field and right 
click with the mouse. A button "Unlock current Field" will 
be shown click on this and the field is unlocked. 
To view which fields that's been locked from further 
editing select the menu option "View | Show 
Fieldborders". Locked fields will be shown with a red 
border. 

Preprinted fields 

LabelCraft will allow the user to add fields to the label that 
are only to be shown as an illustration of preprinted parts 
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of the label. This fields could be used to identify products, 
information to an operator prior to printing among others. 
A preprinted field can be locked to prevent unwanted 
movement of the field. 
When using preprinted fields the user can change the color 
of the field to confirm to the need. Bitmaps will be shown 
in color even thou the label printer only supports two color 
printing (B/W). If a preprinted field are changed back to an 
ordinary field and the printer only supports B/W the field 
will automatically be changed to black. 
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Error messages 

DCB-Table error 

This error message is shown when there is a conflict 
between the port setup in Windows and LabelCraft. In 
order to correct this error change the comport settings of 
the port that you will be using. (Start-Menu, Settings, 
Control Panel, System, Device Manager, Ports Select the 
port that you are using and click on tab marked Port 
Settings. Change Flow-control to None 
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Printing problems 
 
After pressing the OK button in the print module no labels 
are printed. Check following points: 

• The PC is connected to printer with a correct printer 
cable. 

• The printer cable is connected to the right printer ports 
on PC and printer. 

• The printer is turned on and in ‘Online’ mode. 

• The printer is setup to use current communication mode 
(Serial or Parallel [Centronics]). 

• If using Windows 95/98 or NT 4.0 make sure that a 
windows printer driver is installed on the port that you 
are using. 
NOTE! 
If you are using COM port and Windows NT and 
Windows 2000 you are not able to use a printer device  
to be installed on the COM-port that you want to use. 

• Use option print to file and enter into MS DOS 
command mode. Copy the command file direct to the 
printer. 
Copy <filename> <port>    ; copy test.prn lpt1 
If the label is printing OK, the problem is located within 
Windows. 

• Try to change the windows printer device setting to use 
Spool setting to print directly to printer. If using a 
spooler change setting to data format to RAW. 

• Try to change your printer driver, we normally 
recommend using IBM Generic Graphics printer driver 
with spool setting data format to RAW. 

• If printing to a network connected printer you must 
deactivate the printer spooler function in the menu 
option "File | Setup … - Options". 

Data is misplaced or larger/smaller on label after printing. 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 129

• Check printer resolution against the driver in LabelCraft. 

• If wrongly positioned try changing the label left and top 
origin.  



 

 

PART 2: ASCII File Server 
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What is the ASCII File Server? 
The ASCII File Server is a module that can be added to the 
LabelCraft program. You use the module to print address 
labels, product labels and other types of label sets that 
require different texts on each label. 
The information printed on the labels comes from a data 
file. If you want to print address labels, the data file may be 
your customer index. If you want to print product labels, 
the data file may contain product number, product name, 
color and a bar code. 
The data file is usually a text file (.txt format) with one line 
for each label. The items on each line are separated by a 
punctuation mark, generally a semicolon, or with fixed 
length for each field in the record (line). 
You can type the data file yourself, or retrieve it from some 
other application or a database and save it on your PC 
using the .txt file-type extension. 

 

 
 

  Data file    Label template  
 Printed labels    

The ASCII File Server is easy to use and has many useful 
special features. You can, for example, print labels with 
different layouts in the same batch. You can also limit the 
data from the data file by using advanced selection criteria. 
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Making a label with the ASCII File Server 

STEP 1: Start the ASCII File Server 

1. Double-click on the ADBSERV icon. You see the 
startup window: 

 

 
 

2. Click on Options. You see the ‘Specify ADBSERV 
options’ window. 
If the correct settings are used, in the “ini file” for the 
ASCII file server, the LabelCraft program will be 
launched when selecting the menu option “Options”. 

3. In the field Server name the ASCII File Server 
suggests ‘LabelServer’. Use this name if you need 
only one label system. 

 If you want to use more than one label system at 
the same time (for example address labels and 
product labels), you must define different server 
names for each system. See the section ‘Using 
different label systems’. 
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4. Press the TAB key to move to the next field. 

5. In the field Topic name, the ASCII File Server 
suggests ‘LabelData’. Use this name if you need only 
one label system. Press the TAB key to move to the 
next field. 

STEP 2: Choose the data file 

The cursor is now in the field ‘Data file name’. 
If you have a data file, type the file name (or search for the 
file by choosing Find data file). 
If you do not have a data file, you must create it now. To 
create a data file: 

1. Click on Browse file. You see the Notepad. 

2. Type the information needed for the labels. For 
example, to make address labels, type each 
customer’s name, address and postal code. Use a 
semicolon, for example, as the separator and make 
one line for each label. 
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3. When you have typed all the information, choose 
Save from the File menu and close Notepad.  

4. You see the ‘Specify ADBSERV options’ window. 

STEP 3: Define the label fields 

NOTE! Always define the label fields before starting to 
design the label. 

1. Move the pointer to the Field names box. The fields 
you define in this box must correspond to the 
information in the data file. 

2. Click on the New button. You see the ‘Edit Field 
Name’ window. 

 

 
 

3. Type the name of the first field, for example ‘Name’, 
and click on OK. If you want to make a constant field (a 
field with text only in the database system, but not on 
the TXT file itself) Select 'Constant field'. A text box will 
be shown and allows you to enter fixed data into this. A 
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constant field is useful when making Groups and 
calculations. 

 
 

 

 
When using the option “Fixed field lengths” you will 
see a new text box in the dialog box “ Edit Field 
Name”. In this text box you have to enter the no of 
characters that  

4. Repeat this for each of the other fields. The ‘Field 
names’ box may now look like this: 

 

 
 

5. When you are ready, click on OK to close the 
window. 

STEP 4: Save the setup 

1. You see the startup window: 
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2. From the File menu choose Save Setup File. This will 
save the file as default by the name it was opened 
with (ADBSERV.INI). If you want to use another 
name for the setting use, the menu options Save 
Setup File As. 

3. Minimize the startup window. 

STEP 5: Open LabelCraft 

1. Go back to the menu “Options”. Select a label in the 
section “Labels” in the dialog box. 

2. Press the button “View label…”.  You will now see 
the selected label in LabelCraft. 

3. From the File menu choose New. You see the ‘New 
Label’ window. 

 

 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

137  

3. Click on Database info. You see the ‘Database 
Information’ window. 

 

 
 

4. Ensure that the Server name and Topic name are the 
same you used in Step 1, substeps 3 and 4. If you 
have just one label system, use ‘LabelServer’ and 
‘LabelData’. If you use up to four label systems at the 
same time, each system must have a different server 
names/topic names. See ‘Using different label 
systems’. 

5. Click on OK.  
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STEP 6: Design the label 

1. Type the Label Width and Label Height. 

2.  Choose Target printer. 
 

 
 

3. Click on OK. You see the ‘Label Editor’ window. A 
box indicates the label size.  

4. Click on the one-line text field icon (or choose Field / 
Text from the menu). You see the ‘Text Field’ 
window. 
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5. Click on From database no. and choose the data file 
you want from the list. You can have up to four data 
files. Always choose 1 if you have just one label 
system. (If you have several label systems, see the 
section ‘Using different label systems’.)  

 

 
 

6. From the Field name list choose the first field you 
want to edit, for example ‘Fname’. 

7. Click on the button “Get data”.  

8. ASCII File Server fetches the text from the first line in 
the data file and places it in the ‘Contents’ field. Click 
on OK. 
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9. You see that the ASCII File Server has placed the text 
in the label box. Position the text by dragging it. 

 

 
 

10. Repeat sub steps 5 through 9 for the other fields.  

11. From the Menu Line choose File/Save as. 

12. Give the label a name and save it in the Label 
directory. 

13. In the top right hand of the screen you will see the 
following dialog box: 

 
Click on this button to go back to LabelCraft. 

14. You will come back to the dialog box “Specify 
ADBSERV options” in ADB32 program. 

STEP 7: Print the labels 

 
 

1. Click on Print. 
 You see the ‘Print Options’ window. 
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2. Click on OK. 
 

NOTE! If you click on AutoPrint in the ‘Specify ADBSERV 
options’ window, the system will start printing directly, 
without opening the ‘Print Module’ window. 
You are also able to print from the menu selection 
“Options” in ASCII file server program. Select the label file 
that you created in step 6. Then click on the button Print. 
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Multiline textfields 

It is possible to import multiline textfields from a file.  

1. Start ADB-server 

2. From LabelCraft, click on Multiline textfield. 

3. In the ‘Text Field’ window, click on From database 
no. and Database setup. 

4. Give the right Database field name and click on Get 
data. 

5. Textfile name will be read from database file, and 
ASCII File Server fetches the text from text file, and 
places it in the Contents field.  

6. Click OK. 
 

 
 

The fieldname txtfield is a textfile name in the database file. 
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Graphic fields 

Logos, figures and other bitmaps can easily be imported to 
the labels. Example is shown below: 

1. Start ADB-server. 

2. From LabelCraft, click on Graphic field. 

3. In the ‘Graphic field’ window, click on From 
database no and choose the right field name. Click on 
Get data. 

4. ADB-server will read the file name (default .bmp) 
from database file, and place it on the label. 

5. Click OK. 
 

 
 

ASCII File Server will fetch the file LOGO_JS.BMP, and it 
will be printed on the label. 
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Printing different quantities of each label 
The ASCII File Server enables you to print as many copies 
of each individual label as you want. To define the number 
of copies for each label, you must include a ‘count’ item in 
the data file. 

1. In the ‘Specify ADBSERV options’ window, click on 
Browse file. You see the data file. 

 

 
 

2. For each line, type a number specifying the number 
of copies you want of that label. Remember the 
separator (semicolon). 

3. Save the file and close Notepad. The system returns 
you to the ‘Specify ADBSERV options’ window. 

4. Move the pointer to Field names and click on the 
New button. 

5. In the Field name text box type #. 
 

 

6. Click on OK. You see that the system has included 
the ‘count’ field in the field name list. 
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Labels with individual layouts 
To define an individual layout for each label, you must 
include a ‘layout’ item in the data file. This item contains 
the name of a layout that has been defined and stored in 
LabelCraft. To include a layout item: 

1. In the ‘Specify ADBSERV options’ window, click on 
Browse file. You see the data file. 

 

 
 

2. For each line, type the name of the layout you want 
for that label. Default file name is .lbl. 

3. Save the file and close Notepad. The system returns 
you to the ‘Specify ADBSERV options’ window. 

4. Move the pointer to Field names and click on the 
New button. 

5. In the Field name text box type $. 
 

 
 

6. Click on OK. You see that the system has included 
the ‘layout’ field in the field name list. 
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Group selection (combined fields) 
A group selection is a field that consists of two or more 
single fields. For example, you can merge the fields ‘artno’ 
and ‘type’ to create a single field named ‘artnotype’: 

1. In the ‘Specify ADBSERV options’ window, click on 
New group. You see the ‘Group info’ window. 

2. In the Group name field, type a name for the group 
selection.  

 

 
 

3. In the Group string field, type the fields that the 
group selection will consist of. Use a % as a separator. 
You are also able to add fields into the group by 
pressing the button 'Field' this will open a new dialog 
box where you select fields defined in the 'database'. 
If you need space between fields add these before 
adding a new field. 
You are also able to use simple arithmetic operations 
in this group function. If a field contains a price you 
are able to make a new price based on a constant. 
This constant can be written directly into the group 
string or be defined as a constant field. See the 
following examples: 
Group string: 
[%price<*>%dealerpr]  ; where 'price' is located in the 
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text file and where 'dealerpr' is a defined constant in 
the database setup. 
[%price<*>%1.05]  ; where  'price' is located in the 
text file and where '%1.05' was added into the group 
function by pressing the button 'Constant'. 

4. When you create the label, choose the group selection 
from the ‘Field names’ list. The two fields ‘Fname’ 
and ‘Lname’ will be printed as a single field on the 
label. 

5. There is also a new function that allows the user to 
insert a <CR> between each of the fields. Select the 
field and push the button “New line”. The field name 
will be followed by <L>, which indicates a carriage 
return. This group has to be inserted as a multi-line 
text field or into a Datamatrix or PD417 field to be 
used. 
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Printing selected information from the data file 
The ASCII File Server has advanced selection routines that 
enable you to choose exactly which items to include in a 
printout. 

1. In the ‘Specify ADBSERV options’ window, click on 
Record selection.  

2. You see the window ‘Set record selection criteria’. 
You can define up to four selection criteria. You do 
this by using special symbols or operators: 

Operator Explanation Example 

= is equal to Postal code = NY 10020. 

You include all customers with this 
postal code. 

> is greater than Postal code > NY 10020. 

You include all New York 
customers with postal codes higher 
than 10020. 

< is less than Postal code < NY 10020. 

You include all New York 
customers with postal codes lower 
than 10020. 

>= is greater than or 
equal to 

Postal code >= NY 10020. 

You include all New York 
customers with postal code 10020 
and higher. 

<= is less than or 
equal to 

Postal code <= NY 10020. 

You include all New York 
customers with postal code 10020 
and lower. 

  
 NOTE! The operators also work on letters. For 

example, ‘Name < D’ means that you include all 
customers with names starting with A, B or C.  

 By clicking on ‘NOT’, you get the opposite of what 
you chose. 
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 You can combine the selection criteria by clicking 
on ‘And’ or ‘Or’: 

 

And Both criteria must be met 

Or One criterion must be met 
 
 

 You will now learn how to define selection 
criteria. In our example you want to include all 
New York customers who have postal codes 
10020 to 10080 and names that start with A. 

3. In the top No. field type 1. 

4. From the Field name list choose the field you want to 
base the selection on, for example ‘Postal code’. 

5. Click on the = button. The ASCII File Server loads all 
the postal codes into the ‘Value’ list. 

 

Postal code NY 10020

 
 

6. From the Value list, choose the value you want, for 
example ‘NY 10020’. 

7. Click on the Equal or larger operator (>=).  
 The selection now includes New York customers with 

postal code 10020 or higher. 

8. Click on the And-button. 

9. In the next No. filed type 2. 
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Postal code NY 10020

Postal code NY 10080

 
 

10. Choose Postal code <= NY 10080. 
 The selection now includes New York customers with 

postal code from 10020 to and including 10080. 

11. Click on the next And button, type 3, choose Name, 
type A* in the Value field, and click on the Equal 
operator (=). 

 The selection now includes New York customers with 
postal code from 10020 to 10080 and names that start 
with A. 

Postal code NY 10020

Postal code NY 10080

Name

 

12. Click on Print.  
 If you check ‘AutoPrint’, the ASCII File Server 

will start the printout directly, without opening 
the ‘Print Module’ window. 

Advanced selection criteria 
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Wildcard characters 
In the ‘Value’ field, you can use the wildcard characters? 
(Question mark) and * (asterisk): 

? Replaces a single character.  

Example: In a product list you can type B???? to include 
products with the colors BROWN and BLACK (but not BLUE). 

* Replaces any number of characters. 

Example: Type A* to include all names starting with A. 

 
The ‘1+2+3+4’ button 
By clicking on the ‘1+2+3+4’ button, you can combine two 
or more selections and place the result in the ‘Value’ list. 
You can then process this new selection further, for 
example by combining it with other selections.  

1. Define selection criterion No. 1, for example ‘Name = 
K’. 

2. Define selection criterion No. 2, for example ‘Postal 
code = NY 10020’. 

3. Click on the 1+2+3+4 button. 

4. The ASCII File Server combines the two selection 
criteria and places the result in the ‘Value’ list on line 
one. This list will now include all customers who 
have postal code NY 10020 and names that start with 
K. 

Note: 
No. fields must be empty when record selection is not 
used.   When using record selection, other activities 
cannot read from database file. 
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 Using different label systems 
When you install the ASCII File Server, it has a setup file 
named ADBSERV.INI. This file opens automatically when 
you start the system. 
If you want to use different label systems (one for your 
customers, one for your products and so on), you should 
create a setup file for each system. Switching from one 
system to another will then be very easy, since the setup 
files have recorded all the choices you made.  
To create a new label system with its own setup file:  

 

In the ASCII File Server: 

1. Start the ASCII File Server. 

2. Click on Options. 

3. In the fields Server name and Topic name, the 
system suggests ‘LabelServer’ and ‘LabelData’ 
respectively. These names identify the original setup 
file (ADBSERV.INI). To create a new system, with a 
new setup file, you do not need to type in new names. 
You can choose any names you like. If you want to 
have up to four systems at the same time, you must 
give different server names/topic names. 

4. Choose the data file you want and create the label 
fields.  

5. From the File menu choose Save setup file.  

6. The ASCII File Server creates a new setup file for this 
label system. 

 

In LabelCraft 

1. In the ‘Database information’ window you see the 
names of the labels systems that you have defined. 
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2. Choose the label system you want to use; that is, the 
same as in the ASCII File Server. 

3. Click on OK. 
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Advanced setup 
 

 
 

Advanced setup enables you to choose following settings: 

• choose browse editor, default editor is 
notepad.exe 

• restore screen size and position 
• ASCII File Server window always on top 
• open LabelCraft and desired label by clicking 

«Print» on ASCII File Server’s menu line and in 
«Options» by click on button 'View'.  
Note! use parameter –e and –i in order to start 
LabelCraft directly in edit mode and as an icon. 

• If the label file is located in another directory put 
the label path into the text box 'Label file dir.' 

• If using another TXT type as for instance a CSV 
file type this in the text box for 'Default ASCII 
File Type' 

• If you want to start the application in Print studio 
or a special Print studio or as a multi-user 
database mark the correspondent option. 

• To rename the file instead of deleting it after 
using the menu option "Server | File detect 
print". Target name can be wild cards. 

• COM server options to allow the usage of 
termination character in server responses. The 
termination character must be entered in a HEX 
value.  

 
 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

155  

 

File: LABEL.INI 

File LABEL.INI enables you to define your formatting 
characters if the default conflicts with your character set. 
DDE server defines which server program is to be used.  
ServerProgram=ADBSERV; Using ASCII File Server 
ServerProgram=ODBC2000, Using ODBC Server 

 

 
 

NOTE! 
Do NOT change DDE server ServerName or DDE 
ServerTopic. If these two settings are changed, LabelCraft 
will not be able to receive data from the programs 
ADBSERV or ODBCSERV. 
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Server 
Automatic printing 

If you receive files for printout from a host computer, you 
may find it impractical to save all these files. Instead, you 
can instruct the ASCII File Server to print the files 
automatically, and then delete them from your PC: 

1. Start the ASCII File Server.  

2. In the ‘Specify ADBSERV options’ window, specify 
the name of the file you want to print automatically. 

 

 

3. In the startup window, choose Server / File Detect 
Print.  

 Next time a file with this name arrives, the ASCII 
File Server will print it and then delete the file 
from your PC. 

 Wildcards (*.txt) is possible. The files will be 
detected, printed and deleted in order of 
appearance. 

NOTE! If you want to test this feature, please make sure 
that you have a copy of your .TXT file. After printing 
the .TXT file will be deleted. The record selection must be 
setup to be 'Blank', since this will override the possibility to 
print more than one record. 
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COM port server 

The COM port server is a function within the ASCII file 
server program that enables the use of data from a COM 
port to print labels. The COM port server has it own 
protocol. This protocol is described in COM Port Server 
packet protocol. In most cases, you must write a filter 
module to convert the data stream from the source to be 
readable by the COM Port Server. Please visit our web site 
[ www.labelcraft.net ]to download a sample file for a scale.  
If you have a filter module (must be ordered separately or 
built by your self), you can connect digital scales or other 
instruments to your PC and print labels with variable 
specifications. The ASCII File Server prints the labels 
automatically the moment COM port server detects data 
from the instrument. 

 

To set up the COM port system: 

1. Contact your dealer to find out which types of scales 
or instruments you can use. 

2. Connect the device to the serial port (COM-port) of 
your PC. 

3. Start the ASCII File Server. 
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4. From the startup window choose Server / COM port 
server. You see the window ‘COM portserver’. 

 

 
 

5. Click on Port Setup. You see the window 
‘Transmission Parameters’. 

 

 
 

6. From the list Filter module choose the correct type of 
device, if any. If not, make your COM port setup and 
click OK, then go to item 10. If you have a device 
needing filter module setup, proceed on item 7.  

7. Click on Filter Info to see the filter parameters. 

8. Click on Setup and choose 
- current function for the specific filter 
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9. Click on OK. 

10. Place something on the scale (if a scale is used) 

11. Go back to the startup window and click on Options. 
You see   the ‘Specify ADBSERV options’ window. 
The field names are automatically defined. 

12. Save the setup. 

13. Start LabelCraft and design the label. 

 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 

160 

COM Port Server packet protocol 

The host computer initiates all COM port data transmissions. Data 
from the host computer is sent as a package with the following 
format: 

<STX> <Command> (,<Parameter1>,..<ParameterN>)<CR> 
STX Start of text character, HEX 02 
<Command> Packet command, see below 
<ParameterN> Optional command parameter 
<CR> Carriage return, HEX 0D 

 

All characters not within STX .. CR are ignored (and legal). 
All characters within STX .. CR are readable ASCII characters. 
For each packet sent from the host computer, the server answers 
with one-byte ASCII status byte. If the server detects an illegal 
command, a status byte containing ‘9’ is sent back., 
Packet commands: 

STATUS Request server status 
 Parameters: None 
 Response: 0 if idle and ready 

1 if busy printing 
Example: <STX>STATUS<CR> 

 
LABEL, <Labelname> Switch to a new label 
 Parameters: <Labelname>name of new 

label 
 Response: 0 

8 if LabelCraft program not 
loaded 

Example: <STX>LABEL,ORDER<CR> 
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FIELD, 
<Name>,<Data> 

Send label field data 

 Parameters: <NAME> name of field 
<DATA> field data 

 Response: 0 
Example: <STX>FIELD,NAME,Tom Smith<CR> 

   
PRINT, <nLabels> Start printing 
 Parameters: <nLabels> No. of labels to 

print 
 Response: 0 if print started 

8 if LabelCraft program 
not loaded 

7 if LabelCraft is busy 
printing 

NOTE! When printing is 
finished, the server sends  
a 2 to the host computer 

Example: <STX>PRINT,5<CR> 
 

REFRESH Refresh LabelCraft screen with the new 
data 

 Parameters:  
 Response:  
Example: <STX>REFRESH<CR> 

 
ALARM Get alarm code from printer 
 Parameters:  
 Response:  
Example: <STX>ALARM<CR> 

 
RIBBONLENGTH Get ribbonlength from printer 
 Parameters:  
 Response:  
Example: <STX>RIBBONLENGTH<CR> 
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ICON Iconize LabelCraft 
 Parameters:  
 Response:  
Example: <STX>ICON<CR> 

 
EDIT POPUP LabelCraft (from being 

iconized). Prepare for label editing. 
 Parameters:  
 Response:  
Example: <STX>EDIT<CR> 

 
RESETRIBBONLENGTH,port Reset ribbon length for 

printer on port 
If port not specified, 
DEFAULT port for label will 
be used 

 Parameters:  
 Response:  
Example: <STX>RESETRIBBONLENGTH,port<C

R> 
  

 
FLUSHLABEL Be sure last label in a batch is printed, 

even if not all rows/columns are filled 
up. 

 Parameters:  
 Response:  
Example: <STX>FLUSHLABEL<CR> 
  

 
 

The following table summarizes the possible status responses 
from the COM port server: 

0 -Packet accepted / COM server ready 
1 -LabelCraft is busy printing 
2 -Printing finished 
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7 -LabelCraft is busy printing 
8 -LabelCraft program not running 
-1  -Cannot open port (ALARM/RIBBONLENGTH) 
-2  -Printer is not online (ALARM/RIBBONLENGTH) 
-3  -Unknown error (ALARM/RIBBONLENGTH) 

Print Studio 

The print studio option is a printing studio option that 
enables user to specify what label to print and what ASCII 
file to get the data from. 

 
After selecting the Label the user are now able to preview 
the label by pushing the button View label. In normal 
operations the user will see a preview inside the print 
studio dialog box. 

 

Option menu 

The menu 'Options' in LabelCraft contains many functions 
that will ensure an easy use of the ADBSERV.EXE program. 
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Here is a description of the different functions: 

Server name Server name of this database 

Topic name Topic name of this database 

Find datafile… Opens a file selection window to select the data file 
to use 

Browse file… Opens the data file with the editor that is setup in 
the 'Advanced Setup' in the File menu. 

Field separator The field separator used in the data file. If wrong 
file separator is used all fields will be shown as one 
large field. 

Space=normal 
char. 

Hatching this option will make spaces in the field 
as normal characters. 

"=normal char. The sign is a text delimiter in normal applications. 
If this sign is normal sign and not a text delimiter 
hatch this option 

Ansi coding If this file is based on MS DOS text and not 
Windows ANSI use this option to display special 
characters. 
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Skip first line Select this option if the first line is a heading of the 
text file. When this option is selected you will be 
able to generate field names based on the content of 
the first line. 

Fixed field 
lengths 

Select this option if the data fields are using fixed 
field length to separate the fields. When using this 
option you will see the following dialog box when 
adding a new field: 

 
The field length is the length of the current field.  

View label… Use the drop down box to select the label that you 
want to be view.  
This drop down box will only show files listed in 
the directory that is specified in the 'Advanced 
setup' 

Print Print the label that is shown in the drop down box. 
The No. of labels printed is the No. shown in '# 
same records' or if defined in the record if this is 
setup in field names. 

# same records Set the No. of each record to be printed. 

Auto print Start the printing directly without showing the 
dialog box 'Print' in the LabelCraft program. 

Cut: Set the No of labels between each cut operation in 
the printer. Note ! Printer must be equipped with a 
cutter and that LabelCraft support the cutting 
function in this driver. 

New… Adds a new field into the database. By default this 
is added as the last field.  
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Insert… Inserts a new field in front of another field if this is 
selected. 

Delete Deletes the selected field. 

Update… Updates a selected field, and enables a user to 
change the data of this field. 

New group… Adds a new group in database. See 'Group 
selection' 

Clear All Delete all fields that is defined.  
Note! This is not a reversible function. Pressing this 
button could mean a lot of damage. 

OK Close the Option dialog box. 
Note! The setup file is not updated. To update the 
setup file select File menu and 'Save setup file' or 
'Save setup file as'. 

Cancel Cancel all changes and close the dialog box. 

Record 
selection… 

Opens the dialog box 'Record selection'. This dialog 
box is also shown when selecting Record selection 
in the menu bar. 
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PART 3: ODBC2000 Server
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Introduction 
ODBC (Open DataBase Connectivity) is a Microsoft 
Windows addition, which allows application programs to 
access databases of various kinds, using a common 
interface. 
Currently, ODBC supports all major database systems (and 
data source types), for example, Microsoft Access, 
Microsoft FoxPro, Microsoft Excel. dBase, ORACLE, 
Paradox, databases supporting an SQL server and ASCII 
text. 
The ODBC Server for LabelCraft thus provides access to all 
major database systems, using the same kind of interface. 
Furthermore, using the ODBC Server to access a database 
has the following advantages: 

• Data is fetched directly from the database instead 
of being copied and stored separately. This 
means that you use the most up-to-date data, and 
you avoid the possible problem of keeping two 
separate copies of data. 

• Keeping the data only in one database means that 
maintaining security is easier. 

 
NOTE ! 
Microsoft ODBC comes in a 16-bit and 32-bit version, and 
the drivers for the 16-bit and 32-bit are not compatible. It 
is not possible to connect a 16-bit application to a 32-bit 
ODBC driver, but you will in many cases be able to read 
from a 16-bit database if the 32 bit ODBC driver support 
this option. ODBC2000 is a 32-bit application and will 
only run when using the following operating systems: 
Windows 95, 98, Me, WinNT 4.0, Windows 2000 and 
Windows XP (Home and Pro) 
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The ODBC2000 and LabelCraft 
When the ODBC2000 program is used it is to find data and 
to generate a label based on this. It could be one label or it 
could be many labels depending on the selection that has 
been done. A record selection is a query that is sent from 
the program through the ODBC driver and into the 
database to retrieve data corresponding to the criteria set in 
the query. 
ODBC2000 will handle relation databases and using 
queries that will make selections across tables and fields. 
But bear in mind that queries that are linked through 
several tables may have long response time depending on 
the structure of the database you are using.  

Starting the ODBC2000 program 

To start the program select the ODBC2000 program icon in 
your LabelCraft program group. When you start the 
program, you will see a dialog box to select what language 
to use. Select the language and press the “Ok” button. 

 
The program will now load LabelCraft program as well as 
the ODBC2000 program. 

Setting up the ODBC2000 program 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 

170  

When you are going to use the ODBC2000 program it will 
in most cases be working without any problems. But if you 
are setting up the program to use another directory or 
other there is a probability that you have to modify the 
program setup. This is very easy to do. Select “Options” on 
the menu bar. Then select “Setup”. 

 

 
 

Then select “Setup”. You will then see the following dialog 
box: 

 

 
 

Under the first Tab (Files Path’s) you can set up the paths 
for the placement of the Label files (*.LBL) and Query files 
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(*.QRY). These paths will be the new default paths for the 
program to use. 

 

 
 

Under the second Tab (Filenames) you can set up the 
default label file to be opened when starting the program, 
as well as giving a new path to start the LabelCraft 
program from. 
NOTE! After Plabel.exe there are two parameters enclosed 
(-i –e). These two parameters will ensure that the program 
is opened in Edit mode and as an icon on the desktop. 
Under the third Tab (Print options) you can set up the 
program to show the print dialog box when printing. This 
option will allow you to change the printer when printing 
the query / Selection. 

 
The options Stop between different labels will not work in 
the quick search mode. It will function with the Print 
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button in the main window or when using the Print button 
in “Modify Query” window. 

 
 

Setting up LabelCraft to use the ODBC2000 
program 

In normal cases there is no need to setup LabelCraft to get 
data from the ODBC2000 program. If you have previous 
label files (*.LBL) that have been used and want to use the 
layout and the format of the fields again you will have to 
modify the format of the label files. This modification is 
easy to do, but it must be done on all the old labels that 
you want to use.  
Open LabelCraft and select menu option “File | Modify 
Format”. Then click on the button “Database info…”. The 
following dialog box will be shown: 

 

 
 

Make sure that the name and topic is the same as the one 
shown in the picture. 
In some cases there has been some misunderstanding 
regarding the input in the setup part of the LabelCraft 
program. Please note that database option (tab) of the 
menu option “File | Setup” the following data must be in 
place: 
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If these are changed ODBC2000 will not be able to 
communicate with LabelCraft. 
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How to use ODBC2000 
In this section, you will find some examples of using the 
ODBC2000 to fetch data from a database and into 
LabelCraft. 

Example 1: How to use a database to make 
nametag labels. 

In this example, you will see how the ODBC Server is used 
to fetch data from a simple database to produce labels. 
The data is stored in a Microsoft Access database, and is 
supplied with LabelCraft 

The database 

The database is a simple Microsoft Access database 
containing several tables, but we are using the table 
'Student'. The following fields will be used in LabelCraft: 

• StudentId 
• Name 
• GradYear 
 
 

All these fields are text fields. 
 

Defining the data source 

 ODBC2000 uses the connections that are in place in the 
USER DSN and SYSTEM DSN. In most cases these are in 
place, but we will define an USER DSN from scratch. This 
new USER DSN is setup to be working on a specific file 
(STDREG.MDB). This file is a Microsoft Access database.  
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First, establish the connection to a Microsoft Access data 
source. 

1. This is done by starting the Windows Control Panel, 
and double-clicking the ODBC 32 icon. 

 The ‘ODBC Data Source Administrator’ dialog 
box is then shown: 

 

 
 

2. In the ‘ODBC Data Source Administrator’ dialog box, 
click Add. 
The ‘Create New Data Source’ dialog box is then 
shown: 
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3. Select the driver that you want to use. In this case it 
will be the Microsoft Access driver (*.mdb). 
The ODBC Setup for Microsoft Access dialog box is 
then shown: 

 

 
 

4. Enter a Data Source Name (for example Student) and 
an optional description. 

5. We are only going to use one single database; thus 
this database can be set as the default database for 
this data source. 
To do so, click Select Database. 
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The Select the default database dialog box is then 
shown: 

 

 
 

6. Enter the name of the data base file, or use the Drives, 
Directories and List Files of Type boxes to select the 
default database file. Then click OK. 

7. Click OK in the ‘ODBC Setup for Microsoft Access’ 
dialog box. 

8. Click OK in the ‘ODBC Data Source Administrator’ 
dialog box. 

9. Exit the Control Panel. 

Setting up the ODBC2000 

1. First, start the ODBC2000 by double-clicking its icon. 

 The ODBC DDE Server - New query dialog box is 
then shown: 
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2. In the Options menu, select Connection Wizard. 
This will open the ‘Datasource’ dialog box. Select 
the USER DSN (Student) that we just defined. 
 

 
 

Click on the button 'Next' to continue. 

3. You will now se the ‘Tables’ dialog box. Select the 
Student table from the dropdown list to the left in 
the dialog box. Then push the button Next. 
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4. Next dialog box is called Fields. This dialog box 
enables to select what fields that you want to use.  
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To select all fields press the button All. Otherwise 
you are able to select the field one by one from the 
left dropdown box. If you want to remove a selected 
field just double click on it and it will be removed.  
In our example click on the button 'All' since we are 
going to use all three fields. Then press the button 
Next. 
 
NOTE! Only fields that located in the tables that you 
selected will be available for selection. If you are 
missing fields go back to select the table that 
contains the fields you need.  

5. Selection dialog box is the next step. In this dialog 
you are able to do a selection to limit your data to be 
printed.  
In some cases this is the dialog you have to use 
when your selection shall be limited by selection 
from more then one table or that the selection 
criteria covers more than one field.  
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In this case press the button 'Next' since we are 
going to use all data in this table. 

NOTE! If you do not know what content to look for, 
you will be able to use the menu function "Options 
| Modify Query" after the query (selection) has 
been made.  

6. You will now see the dialog box 'View Records'. 
This dialog box shows the result of the selection 
from previous dialog. 
 

 
 

You are able to scroll trough the selected records by 
pushing the buttons 'Next', 'Previous', 'First' and 
'Last'. There is also an option to modify the output 
format of the fields in this dialog. The field types 
(Numerical and Date/Time) can be modified. This is 
done by right click on the field where you want to 
modify the output format. How this will be done is 
shown in another example. 

Press the button 'Next' to continue. 
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7. You are now moved into the Label section of the 
query. The following dialog box ' Label' will now be 
shown on screen. 
 

 
 

In this dialog box you are linking the query to a 
label file. If there is no file present select the label 
'New Label' to add a new label to your system. Then 
press the button 'Finish'. 

8. Now a dialog box will be opened on the screen that 
asks for a file name for the new label file. 
 

 
 

Enter the name for the new label file. We are using 
the name 'Student'. Then press OK. The system will 
now ask you to save the query. Press the button 
'Yes'. 
 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 

183  

 
 

The dialog box 'Save As' will then be shown. Save 
the file as Student. 
 

 
 

Press the button 'Save' and the query file will be 
saved. Then the program will open LabelCraft. 

9. You will now see LabelCraft in Edit mode, but with 
no label defined. Select from the menu 'File | 
Modify Format'. We are using the PWIN driver and 
using the no. of labels across to be 2 and labels in 
height to be 10. This gives the following format: 
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Press the button 'Ok' and you will be returned to the 
edit screen of LabelCraft. 

10. Now we are ready to add data fields to the label. 
Select menu option 'Field | Text…' or use the icon 

. You will then see the following dialog box: 
 

 
 

Press the Radio button ( ~ ) 'From database no:  1'. 
Then select the field '[Student].[StudentID]' and 
press the button 'Get data…'. In the content you will 
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now see that the data from the first field have been 
inserted. Press the button 'Ok' to confirm the 
selection and to add the field on to the label. Then 
drag the field to the position you want it to be sited. 

Next step is to add the rest of the fields on the label. 
See our result here: 
 

 
  

After all fields have been added on the label select 
menu 'File | Save'. Then click on the button 'Back to 
Odbcserver'. This is shown in top right corner on 
the screen. 
 

 
 

11.  You will now see the label on the preview part of the 
ODBC2000 window. 

 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 

186  

 
 

12. To print the records that have been selected press the 
button ‘Print’ and the print process is started. If you 
need to print more that one label of each record 
change the number in the text box ‘Number of copies’. 
NOTE! This change will be deployed on all the 
selected records. 

Using Quick Search to print labels. 

ODBC2000 has a Quick Search function that enables the 
user to find a record without having to define a query each 
time to print/view. This function is located in the menu 
bar 'Options | QuickSearch'. This function is based on the 
query that you have defined. At current it will only be able 
to handle selection from one field, but this field can be 
linked to other fields in other tables. 
Next we will show an example based on the query that we 
used in the previous example. 
 

1. Start the program ODBC2000, and click in the field 
'Predefined Queries'. Scroll down to select the query 
'student.qry' that we saved in last example. 
The query will now be loaded into the program. You 
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will see the preview of the label in the preview 
window. 

2.  Then select 'Quick Search' from the menu bar in the 
top. The dialog box 'Quick Search' will then be shown 
on screen. 

 

 
 

Note! The query that is the base of this selection is 
shown on the menu bar. 

3. We are now going to search for a student named 
'Shannon, Eric'. We select '[Student].[Name]' from the 
dropdown list box 'Fields'. We will then see the 
following screen: 
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Since this is a short list we are able to click on 
'Shannon, Eric' in the list box 'Records in field'. 
Whenever you select a record you will see a preview 
of the label. 
 

 
 

4. To print 10 labels of this selection you must enter the 
no. 10 in the text box '# Copies' and the press the 
button 'Print'.  

5. If this had been a large database of several thousands 
records it would be time consuming to scroll down in 
the list box 'Records in field'. You would then start to 
enter search criteria in the text box ' Search for'. This 
would speed up the search considerably.  
You may also speed up the selection by modify the 
query. In our example we know that 'Shannon, Eric' 
is a graduate of 96. We would now limit the search to 
those students that has graduate year equal to '96'.  
Press the button 'Modify query' and you will see the 
following dialog box: 
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Select '[Student].[GradYear] in the fields text box. 
Set the radio button in 'Select from' to 'Content'. 
Scroll down and select '96' in the list box below and 
set the criteria to '='. 
Press the button 'ADD' and the criteria are then 
added into the query. 
Press the button 'Quick Search' to return to record 
selection. 
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6. You select '[Student].[Name]' from the dropdown list 
box 'Fields'. The following screen will the be shown: 

 

 

As you will se that the records in field have been 
reduced to be only those with Graduation Year 
equal to 96. 

Example 2: How to select from an Excel file. 
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Spreadsheets are often used when it comes to register data. 
These data records could now be used to generate labels to 
be printed. 
The following example will show you have to use an Excel 
spreadsheet to import data from and the possibility to 
format the fields so that these could be showing the data in 
the order you want it to be. 
NOTE! This spreadsheet will be enclosed with the program 
package from LabelCraft. 

1. Open the spreadsheet EXAMPLE.XLS in Microsoft 
Excel. If you are going to use a spreadsheet from 
Excel you must name the area that you will use as 
data area.  
This will already be done in the example file. But we 
will give a brief explanation on how in the following 
lines: 
Select the area A1..D17. 
Select the menu option 'Insert | Name |Define …'. 
You will see the following dialog box in MS Excel 
2000: 

 

 
 

Change Part_No. to Data and press the button 'add' 
and then the button 'OK'. Save the spreadsheet and 
exit MS Excel. 
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2. Start the program ODBC2000, if it is already running 
then Select the menu 'File | New Query'.  
Select the menu 'Options | Connection Wizard. 

3. Select DataSource to be Excel Files. Then press the 
button 'Next'. 

 

 
 

4. Select the file 'EXAMPLE.XLS' from the LabelCraft's 
main directory. 

 

 
 

Press the button 'OK' to confirm your selection. 
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5. Select the data area 'Data' in the dialog box 'Tables', 
and press the button 'Next'. 

 

 
 

6. In the dialog box 'Fields' press the button 'All' in 
order to select all columns in data area. 
Then press the button 'Next' to continue. 
NOTE! That the first line in the data area that we 
defined is now column name. 
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7. Since we are going to use all the fields in the data 
area, there is no need to make a selection or to set up 
criteria for any relations. 
Just press the button 'Next'. 

 

 
 

8. In the next section you will be able to see the 
selection that you have made as well as what the 
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ODBC driver is returning when it comes to extraction 
of data from the spreadsheet. You will here see that 
the columns that contain text are correct, but the 
columns that contain numbers are sent back with 6 
decimals. This will not work well when it comes to 
reading the data into the label, so we have to modify 
the output format. 
 

 
 

9. To modify the output format you have to right click 
the items that you want to modify. Right click the 
first line and you will see a button 'Format'. Click on 
that and you will see the following dialog box: 

 

 
 

In this dialog box you are able to modify the output 
format, as you want it to be. The [Data].[Part No#] 
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field is to be presented as 6 digits without decimals, 
but with leading zero's. [Data].[Item] should be 
presented with no decimals and no leading zero's. 
[Data].[Price] should be presented with 2 decimals. 
See the following dialog boxes for the results: 
 

 
 

 
 

 
 

Which gives the following result: 
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Since the output format is OK we press the button 
'Next'. 

10. You are now moved into the Label section of the 
query. The following dialog box ' Label' will now be 
shown on screen. 
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In this dialog box you are linking the query to a 
label file. If there is no file present select the label 
'New Label' to add a new label to your system. Then 
press the button 'Finish'. 

11. Now a dialog box will be opened on the screen that 
asks for a file name for the new label file. 
 

 
 

Enter the name for the new label file. We are using 
the name 'Excel'. Then press OK. The system will 
now ask you to save the query. Press the button 
'Yes'. 
 

 
 

The dialog box 'Save As' will then be shown. Save 
the file as Excel. 
 

 
 

Press the button 'Save' and the query file will be 
saved. Then the program will open LabelCraft. 
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12. You will now see LabelCraft in Edit mode, but with 
no label defined. Select from the menu 'File | 
Modify Format'. We are using the LNOVEXX driver  
 

 
 

Press the button 'Ok' and you will be returned to the 
edit screen of LabelCraft. 

13. Now we are ready to add data fields to the label. 
Select menu option 'Field | Text…' or use the icon 

. You will then see the following dialog box: 
 

 
 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 

200  

Press the Radio button ( ~ ) 'From database no:  1'. 
Then select the field '[Data].[Part No#]' and press 
the button 'Get data…'. In the content you will now 
see that the data from the first field have been 
inserted. Press the button 'Ok' to confirm the 
selection and to add the field on to the label. Then 
drag the field to the position you want it to be sited. 

Next step is to add the rest of the fields on the label. 
Save the label with menu 'File | Save'. 
See our result here: 
 

 
  

NOTE! The label shown has been added with a lot 
of special functions in LabelCraft. The data field 
[Data].[Part No#] has been named PNO. This field 
has been used to generate an EAN13 barcode where 
the first part is fixed, the six digits from the database 
have been used as a product no, and an extra digit 
has been added to make the check digit without 
destroying the content of the barcode. The dialog 
box for this barcode is shown below: 
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Further more have we been using the formula to 
convert the price for the data field [Data].[Price]. 
Naming the original field to be EUR did this. Then 
using the formula to calculate a new field with the 
current price in NOK. See dialog box for the new 
field below: 
 

 
 

After all fields have been added on the label use 
menu 'File | Save'. Then click on the button 'Back to 
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Odbcserver'. This box is shown in top right corner 
on the screen. 
 

 
 

 
 

You will now see the label on the preview part of 
the ODBC2000 window. 
 

 
 

14. To print the records that have been selected press 
the button ‘Print’ and the print process is started. If 
you need to print more that one label of each record 
change the number in the text box ‘Number of 
copies’. 
NOTE! This change will be deployed on all the 
selected records. 

15. If you need to print a few labels at time you should 
then be using the menu function 'Options | Quick 
Search'. 
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Example 3, database selection with relations 
between tables 

In this section we will show how you are able to create 
labels where the data from one table is linked to another 
table and where the second table is linked to the third table. 
We are going to use the database STDREG.MDB that is 
supplied with the program. 

1. First, start the ODBC2000 by double-clicking its icon. 

 The ODBC DDE Server - New query dialog box is 
then shown: 

 

 
 

2. In the Options menu, select Connection Wizard. 
This will open the ‘Datasource’ dialog box. Select 
the USER DSN (Student) that we just defined. 
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Click on the button 'Next' to continue. 

3. You will now se the ‘Tables’ dialog box. Select the 
Course, enrollment and student table from the 
dropdown list to the left in the dialog box. Then 
push the button Next. 
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4. Next dialog box is called Fields. This dialog box 
enables to select what fields that you want to use.  
 

 
 

To select all fields press the button All. Otherwise 
you are able to select the field one by one from the 
left dropdown box. If you want to remove a selected 
field just double click on it and it will be removed.  
In our example click on the button 'All' since we are 
going to use all fields. Then press the button Next. 
 

5. Selection dialog box is the next step. In this dialog 
you are able to do a selection to limit your data to be 
printed.  
In some cases this is the dialog you have to use 
when your selection shall be limited by selection 
from more then one table or that the selection 
criteria covers more than one field.  
 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 

206  

 
 

Since we are going to use relations with this 
database we have specified the relations between 
the tables. 

NOTE! If you want to modify the query later you 
can use the menu function "Modify Query" after 
defining the query (selection).  

6. You will now see the dialog box 'View Records'. 
This dialog box shows the result of the selection 
from previous dialog. 
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You are able to scroll trough the selected records by 
pushing the buttons 'Next', 'Previous', 'First' and 
'Last'.  
Press the button 'Next' to continue. 

7. You are now moved into the Label section of the 
query. The following dialog box ' Label' will now be 
shown on screen. 
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In this dialog box you are linking the query to a 
label file. If there is no file present select the label 
'New Label' to add a new label to your system. Then 
press the button 'Finish'. 

8. Now a dialog box will be opened on the screen that 
asks for a file name for the new label file. 
 

 
 

Enter the name for the new label file. We are using 
the name 'Relations'. Then press OK. The system 
will now ask you to save the query. Press the button 
'Yes'. 
 

 
 

The dialog box 'Save As' will then be shown. Save 
the file as Relations. 
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Press the button 'Save' and the query file will be 
saved. Then the program will open LabelCraft. 

9. You will now see LabelCraft in Edit mode, but with 
no label defined. Select from the menu 'File | 
Modify Format'. We are using the LNOVEXX driver  
 

 
 

Press the button 'Ok' and you will be returned to the 
edit screen of LabelCraft. How to add data to the 
label has been shown in example 1 and 2, so if any 
questions look there for the answer. 

10. Save the label and press the button 'Back to 
ODBCServer'. 
 

11. You are now ready to do a selection of records to be 
printed. This can be done in two menu options. 
A) 
Using menu option 'Modify Query' to add the 
selection criteria, and then to go back to main menu 
to print labels. 
 
NOTE! At current version when making a record 
selection that has to meet two values or more from 
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different fields or tables this is the only option. 
 
B) 
Using menu option ' Quick Search' to select records 
that meet a single field content criteria. 
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ODBC2000 Reference Guide 
When you start up the ODBC2000 program, you see two 
programs that are loaded on the PC. One program is 
LabelCraft and the other is ODBC2000. This is the main 
dialog box of the program: 

 

 
 

The various menu selections and buttons are described 
below. 

Main Window 

This is the main window of the ODBC2000 program. It 
contains 3 main elements: 

Preview This will show a preview of the label that is linked with the 
query. This window is linked to program LabelCraft. 
Note! This function is available when using Label Craft's 
own API functions. 

Predefined 
Queries This is a dropdown list box that reports all the queries that 

is available in the directory specified in the menu ' Options 
| Setup'. 

Print 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 

212  

Labels This part of the main window is controlling the print 
options. All buttons are gray until the system is defined 
with a label. 

Edit Label The button' Edit' start's LabelCraft program to edit the 
label. 

Stop Printing The button 'Stop' stops the current print job. 
NOTE! Data that has been sent to LabelCraft will be 
printed. 

Print Query The button 'Print' start the print job. All labels that have 
been defined in the query will now be printed.  

Number of 
copies This text box gives the no. of each record to be printed. 
Exit The button 'Exit' will close down the program without 

saving any data. 
 

File | New Query 

Use this menu option to define a new query for the 
ODBC2000 program. 
When File | New Query is selected all data in the main 
window are flushed (removed), and you will then be able 
to define a new query by selecting the menu Options | 
Connection Wizard. 

File | Open Query 

Use this menu option to an existing query for the 
ODBC2000 program. 

File | Save 

Use this menu option to save the current query. You can 
use 'Alt+F' and the press S as a short cut. 
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If no query were selected, then no action would be taken. 

File |Save As: 'Save As' dialog box 

Use this menu option to save the query with a new name. 
You can use 'Alt+F' and the press A as a short cut. 
When 'File | Save As' is selected, the 'Save As' dialog box is 
shown: 

 
 

 
 

Save in: Specifies what drive and directory to save the data in. 
File name: Specify the file name for saving the query file. 
Save as 
Type: List only files of the file extension specified when showing 

a list of files to be selected. 
Save Press this button to execute the save process. 
Cancel Press this button cancel any changes. This will close the 

dialog box and the program will be returned to previous 
dialog box. 

 
Note! The original query will not be removed. If you need 
to remove the query then you have to open Explorer to 
delete the file. 

File | Exit 
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Use this menu option to exit the ODBC2000 program. The 
LabelCraft program will also be shut down. 

Options | Setup: 'Setup' dialog box 

Use this menu option to specify the program options. 
When Options | Setup is selected the following dialog box 
is shown: 

 

 
 

Under the tab 'File Path's' you must specify the file paths 
for the program. 

Label Files: Use this text box to specify where the label files are to be 
placed. 

Query Files: Use this text box to specify where the query (*.qry) files are 
to be placed. 
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Under the tab 'FileNames' you must specify the file names 
that you will be using. 

Label Name: Use this text box to specify the default name for a label 
when opening the program. 

LabelCraft  
Executable: Use this text box to specify the default name for the 

LabelCraft program. The parameter's '-i –e' must be 
included unless you want to start LabelCraft in the main 
window. 
NOTE! If you have password protected the edit function in 
LabelCraft and only want the user to print labels, then 
change the parameter '-e' with '-p'. The '-p' parameter will 
open LabelCraft in print mode where there is no need to 
supply a password to open the program. 
 

Connection Wizard 

Use this menu option start a wizard to define the query. 
This menu functions opens up several new dialog boxes 
that will help the user to make a new query. 
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Connection Wizard: 'Datasource' dialog box 

This is the first dialog box that is shown: 
 

 
 

DataSource This dropdown list box enables the user to select what 
ODBC driver to be used, in order to connect to the database. 
The datasources are selected from what has been setup in 
the ODBC driver's setup in the control panel in Windows. 
The ODBC2000 program uses the sources defined in USER 
DSN and SYSTEM DSN. 

Back This button is gray until a datasource is selected. When it is 
black you will be able to go back to previous dialog. 

Next This button is gray until a datasource is selected. Press this 
button to continue the definition of the query. Now the 
user will be able to select what database he wants to use, 
unless this has been already setup in his USER DSN. 

Cancel This button will cancel all selections and return to the main 
window. 

Connection Wizard: 'Tables' dialog box 
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In this dialog box will the user be able to select what 
tables/data areas he would be using in his query. The  
'Tables' dialog box is shown: 

 

 
 

Select what tables to be using from the drop down list box 
in the left part of the screen. When selecting a table from 
the list box it will be added in to the window of the right 
side in the dialog box. 
To delete a selected table double click on the table name. 

Back This button will go back to previous dialog. 
Next This button is gray until a table is selected. Press this 

button to continue the definition of the query.  
Cancel This button will cancel all selections and return to the main 

window. 

Connection Wizard: 'Fields' dialog box 

In this dialog box the user will be able to select what fields 
to be used in his query. 
NOTE! You will only be able to use the selected fields on 
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the label. 
The 'Fields' dialog box is shown: 

 

 
 

Select what fields to be using from the drop down list box 
in the left part of the screen. When selecting a field from 
the list box it will be added in to the window of the right 
side in the dialog box. 
To delete a selected field double click on the field name. 

All This button will select all the fields that is connected to the 
tables that was selected in the previous dialog box 'Tables'. 

Back This button will go back to the selection of the datasource 
dialog box. 

Next This button is gray until a field is selected. Press this button 
to continue the definition of the query.  

Cancel This button will cancel all selections and return to the main 
window. 

Connection Wizard: 'Selection' dialog box 
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In this dialog box the user will be able to make a selection 
and to set up relations between fields from different tables. 
NOTE! You will only be able to use the selected fields from 
the previous dialog box. 
 
The 'Selection' dialog box is shown: 
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This dropdown list box selects the first field in the 
argument. 
This dropdown list box sets the operator in the selection. 
The operator's are: 
< Less than 
<= Equal or less than 
<> Not equal  
= Equal 
> More than 
>= Equal or more than 
This dropdown list box is used to enter the value for the 
selection criteria. If the selection is to connect tables to 
signal a relation then the statement would look like this: 
 
[Table1].[Field1]=[Table2].[Field1] 
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This text box will show the selection criteria that have been 
added. If a selection criterion is to be deleted then double 
click on that line.  
 
 

Add This button will add the selection criteria to query. If you 
add more than one criteria you must specify whether next 
criteria should be 'AND' or  'OR'.    

AND This is button is used when you make a selection criteria 
with more than one statement. The 'AND' function will 
give that both criteria's must be met. 
Example: 
 
[Student].[StudenID]=1005 
AND 
[Student].[StudenID]=1006 
 
This statement will return no data found, since it is not 
possible to meet both criteria's. 

OR This is button is used when you make a selection criteria 
with more than one statement. The 'OR' function will give 
that one criteria's must be met. 
Example: 
 
[Student].[StudentID]=1005 
OR 
[Student].[StudentID]=1006 
 
This statement will return the result two data sets since 
both will be met in the database. 

Up This button will move the criteria up in the Selection 
criteria box. 

Down This button will move the criteria down in the Selection 
criteria box. 
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Back This button will go back to the selection of the 'Fields ' 

dialog box. 
Next Press this button to continue the definition of the query. If 

no data has been added into the selection the system will 
assume that all data are to be used. 

Cancel This button will cancel all selections and return to the main 
window in the program. 

 

Connection Wizard: 'View Records' dialog box 

In this dialog box the user will be able to view and modify 
the output format of the selected records. 
NOTE! If you see record 1 of 0 on the screen the selection 
you made has either failed or you have specified a criteria 
that is wrong. Press the button 'Back' to return to previous 
dialog box to fix the problem. 
The 'View Records' dialog box is shown: 
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Back This button will go back to the selection of the Selection ' 
dialog box. 

Next Press this button to continue the definition of the query. If 
no data has been added into the selection the system will 
assume that all data are to be used. 

Cancel This button will cancel all selections and return to the main 
window in the program. 
In this dialog box you are able to view the selected records 
as well as modify the output format on fields that is 
returned as dates or numbers from you database. Text 
fields cannot be modified. Select the field to modify in the 
record view by clicking on it with the mouse. Then right 
click on the same field and you will the following dialog 
boxes.  

Connection wizard: 'View Records| Number Format' 
dialog box 

 

 
Leading 
Zero's When selecting this option the field will be filled with 

leading zero's according to the no. of digits specified. 
Remove 
decimal 
point This will remove the decimal point from the output format. 
Digits This specifies the no. of digits that will be used. If this is set 

to be Zero, the output will still print the correct no. of digits. 
Decimals This will set the no. of decimals in the output.  
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Example This gives an example on the output, but it will not show 
the result based on the current record. 

Cancel This will cancel the format setting 
Exit This will store the format prior to closing down the dialog 

box.   
 

Connection wizard: 'View Records| Date Format' dialog 
box 

 

 
 

Predefined 
formats This area has several buttons with predefined formats. By 

pressing one of the buttons the format field will defined. 
Formats This drop down list box allows the user to build a special 

format. You can also insert "free" text into the format line. 
Cancel This will cancel the format setting 
Exit This will store the format prior to closing down the dialog 

box. 

Connection wizard: 'Label' dialog box 

This dialog box will link the query selection to a label or to 
create a new label. The 'Label' dialog box is shown: 
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Labels This drop down list box is used to select an existing label to 
connect with the query. If you are to make a new label 
leave the 'New Label' in the list box and the press the 
button 'Finish'. 
 

Connection wizard: 'New Query' dialog box 

The 'New Query' dialog box is shown: 
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After the linking between the query and the label file you 
have to save the query since the label file name is a part of 
the query.  

Yes Saves the query 
No Will prohibit the save function. 

NOTE! You will be allowed to continue but it will make no 
effect or enable the use this query. 

Connection wizard: 'Save As' dialog box 

The 'Save As' dialog box is shown below: 
 

 
 

Save After entering the query name in the 'File name' text box 
the file will be saved. 

Cancel Cancels the save operation. 

Connection wizard: 'New Label Name' dialog box 

The 'New Label Name' dialog box is shown: 
 

 
 

OK After entering the label name in the 'Label Name' text box 
press the button to store the file name prior to opening 
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LabelCraft to edit the label. 
 

Quick Search: 'Quick Search' dialog box 

Use this menu option to select a record to be printed. You 
can use 'Alt+O' and Q as a shortcut. 
When Quick search is selected the 'Quick Search' dialog 
box is shown: 

 

 
 

Fields This drop-down list box is used to specify what field to be 
used to select data from. Format of the content is: 
[Table].[Field] 

Preview This window is used to show a preview of the selected 
record. 
 

Search for This text box is used to enable quick search for a product 
when using large tables. By entering the text in the box the 
search for the data is done faster than scrolling in the list 
box ' Records in field'. 

Records in 
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field This list box will contain all the records that is listed in the 
selected field. When no. of fields overflows the list box a 
scroll bar will be displayed. 

#Copies Is used to specify the number of labels to be produced from 
each record that is selected. 

Print Prints the selected record. You can use 'Alt+P' as a short 
cut. 

Modify 
Query Opens the 'Modify Query' dialog box. See Options | 

Modify Query for more details. You can use 'Alt+M' as a 
short cut. 

Exit Close down this dialog box. You can use 'Alt+X' as a short 
cut. 

Modify Query: 'Modify Query' dialog box 

Use this menu option to modify the existing query. You 
can use 'Alt+M' as a short cut. 
When Options | Modify Query is selected the 'Modify 
Query' dialog box is shown. 
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Fields Fields This drop-down list box is used to specify what field 
to be used to select data from. Format of the content is: 
[Table].[Field] 

Operator This drop-down list box is to the right of fields and sets the 
operator for the selection criteria. 

Select from This field contains two radio buttons 
 
Fields, which will give that the value of the far right drop-
down list box is a field name. 
 
Content, which will give that value of the far right drop-
down list box is a content related to the record set. 

Add This button will add the selection criteria to query. If you 
add more than one criteria you must specify whether next 
criteria should be 'AND' or  'OR'.    

AND This is button is used when you make a selection criteria 
with more than one statement. The 'AND' function will 
give that both criteria's must be met. 
Example: 
 
[Student].[StudenID]=1005 
AND 
[Student].[StudenID]=1006 
 
This statement will return no data found, since it is not 
possible to meet both criteria's. 

OR This is button is used when you make a selection criteria 
with more than one statement. The 'OR' function will give 
that one criteria's must be met. 
Example: 
 
[Student].[StudentID]=1005 
OR 
[Student].[StudentID]=1006 
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This statement will return the result two data sets since 
both will be met in the database. 

Up This button will move the criteria up in the query box. 
Down This button will move the criteria down in the query box. 
 
Quick Search This button will open the dialog box 'Quick Search'. For 

more details see Quick Search. 
Cancel This button will cancel the query modification. 
OK This button will save the query temporarily. If this 

modification is to be permanent, then use the menu option 
File | Save to make it permanent. 
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PART 4: Print spooler 
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Introduction 
Print spooler is a program that enables a user to print 
different labels in a batch mode. This program will only 
work with labels that are not connected to a database. 
The program will setup a batch of labels to be printed; it 
also enables the user to save the batches so that it could be 
called up at a later time to start the print jobs. The user is 
also enabled to stop print jobs, so that one can change 
labels and ribbons if that is needed. 
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How to use the print spooler program. 

Start the program by selecting the Icon . The program 
will start and following dialog box will be shown on 
screen: 

 

 
The menu bar contains three choices: File..., Setup….. and 
About.. 
To exit the program select File|Exit or the button 
'Terminate Spooler'. 
 
The first time one are going to use the program check the 
setup of the program select Setup in the menu bar. The 
following dialog box will be shown on screen: 

 

 
LabelCraft Command is the command to start LabelCraft 
and Directory is where the Labels are present.  
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Note! In order to make the program to function properly 
with LabelCraft the options –e and –i must be included in 
the command. 
Press Ok to accept the changes. 
Select a label from the window 'Available labels' by 
clicking on it. Then press Add or double click it to add this 
label or Insert if it is to be inserted into the list. Then enter 
the number of Labels to print. This is selected in the 
'Number to print' box. If you want to halt the print job 
before the selected label is to be printed check box 'Alert 
operator before print'.  
When you have selected the labels that you want to print 
and made sure that the printer is ready you can start the 
spool job. Press the button Start Spool. The print spool job 
will be started. A status window will be presented on the 
screen.  

 

The Status screen contains a list of the selected labels to 
print. Next to the label to print is the No. of labels to print, 
if the jobs is to be paused before printing and the status of 
the job in the queue 
To pause the spooling job press button Pause Spooling. 
To stop spooling job press the button 'Stop Spooling'. 
To start a new spool job press New Spool Job. 
To stop the program press Terminate Spooler. 
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Print Spooler Reference Guide 
When you start the print spooler, you see a dialog box 
containing the menu system. This is the main dialog box of 
the print spooler: 

 

 
 

The various menu selections are described below: 
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File | Open Old Job 

Use this menu option to open a previously saved job. 
 When File | Open Old Job is selected, the ‘Open Old Job’ 

dialog box is shown: 
 

 
 

File Name This combo box is used to select an old spool job to 
be loaded. 

List Files of 
Type 

This combo box is used to select what file type to 
search for. By default it is set to be Old Jobs ( *.lbj). 

Drives Use this combo box to select the drive to retrieve the 
files from. 

Directories The Directories list box is used to select a directory 
to select a file from. 

OK Select this button after a selection is made or double 
click on the selected file name. 

Cancel Select this button to cancel and exit this dialog box. 

Network... The Network button can be used when the file is to 
be located on a network drive, which has not yet 
been defined as a logical drive. 

File | Save Job 

Use this menu option to save an existing Printer spool job. 
The will be default set as type *.lbj. 
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File | Exit 

Use this menu option to exit the program. It will close the 
program and close LabelCraft program if this is active. You 
are also able to use the button ‘Terminate’ in the main 
window to exit the program. 

Setup: ‘Setup’ dialog box 

Use this menu option 'Setup' the program to start 
LabelCraft program correct.  
When Setup is selected, the ‘Setup’ dialog box is shown: 

 

 
 

LabelCraft cmd Specify the program path, name and parameters to 
be used to start LabelCraft.  
NOTE! In order to start LabelCraft correct the 
parameters –e and –i must be included. 

Directory Specify the directory of the label file. 
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About 

Use this to view the dialog box ‘About’. To exit this dialog 
box click button OK. 

 

‘LabelCraft Print Spooler’ dialog box 

This is the main dialog box in the program. 

 
The options are described below. 
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Available 
Labels: 

Is used to select a label to the spool job. You can 
only to select labels from the directory. 
NOTE! Labels that are connected to a database must 
not be used. If you want to use a label with data 
from a database Save the file in LabelCraft after 
making all fields fixed.  

Add Adds a new label to the selected labels for this spool 
job.  

Insert Inserts a new label into spool job. 

Delete Deletes the selected label from the spool job. 

Number to 
print 

Set the number of labels to print of the selected label 

Labels between 
Cuts 

Set the No of labels to be printed between each cut. 
If there is no cutter installed set No. to be 0. 

Empty Labels 
at end 

Specify the No of empty labels to be feed at the end 
of the print job. 

Alert operator 
before print 

Select this option if you need to have the operator to 
change ribbon, labels or take care of labels from 
previous print job. 

Start spooler This button starts the spooler program after the 
selections is done.  

 

Spooler status 

After selecting the button ‘Start Spooler’ a new dialog box, 
which shows the status, is shown. 
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The options is described below: 

Status window This window contains info of each of the files to be 
printed. The column 'Label' is the name of the label 
file. #Labels is the No. Of labels to be printed. Cut is 
the No. Of labels to be printed between each cut. 
Empty is the No. Labels to be printed blank after the 
print job. Operator tells if the label will be printed 
after a stop. The operator will se the following 
dialog box on the screen: 

     
When ready to continue printing select button OK. If the spool job is to be 

cancelled select ‘Cancel’. 
 Status is the status of the job, printed or not printed. 

Stop spooling Stops the spooler temporary. To continue select 
button ‘Resume spooling’.  

Resume 
spooling 

Press this button to continue the spool job after 
having pressed the button ‘Stop spooling’. 

New Spool Job Start the dialog box ‘LabelCraft Print Spooler’ dialog 
box.  
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Terminate 
spooler 

Terminate the spool job. Note! The current print job 
will be printed. If this is to be cancelled the printer 
has to be turned off. 
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PART 5: HIBC Barcode 
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Introduction 

BAR CODE LABELING STANDARD 

In 1983 HIBCC was provided its initial mandate for the 
health care industry:  develop a uniform bar code labeling 
standard for products shipped to hospitals.  This relatively 
straightforward concept represented a dramatic potential 
for the entire industry.  By agreeing to place a consistent 
pattern of computer-readable bar codes on their products, 
manufacturers would provide a control mechanism that 
would yield enormous benefits to both their hospital 
customers and distributors. 
The mandate to develop the standard grew out of a task 
force hosted by the American Hospital Association and 
composed of numerous other health care trade 
organizations, including those, which ultimately founded 
HIBCC.    Bar code technology had already proven a 
valuable tool for reducing labor costs and human error in 
other industries, such as retailing.  In health care, the 
potential was even greater because of the impact errors can 
have on the quality of patient care. 
The task force ultimately created the Health Industry Bar 
Code (HIBC) Standard, composed of two parts:  Part One, 
the HIBC Supplier Labeling Standard, covering the formats 
used by suppliers of products and Part Two, the HIBC 
Provider Standard, covering the formats used for internal 
labeling by health care providers themselves. 
Bar code technology changes rapidly.  Advances in 
hardware have made it possible for "scanners" to 
understand multiple symbologies (the codes which 
translate information into bars and spaces) including those, 
which are used for small-package and unit-of-use 
labeling.  These developments have in turn made bar code 
use far more useful and valuable to the industry. 
The standard has been widely adopted on a global basis by 
both the medical and dental industries.  In Europe, dental 
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products are required to be labeled with HIBCC bar 
codes.  Recent surveys show that the majority of health 
care products with bar coding are using the HIBC 
Standard.  In 1988, the European Health Industry Business 
Communications Council (EHIBCC) was formed to serve 
as a partner to HIBCC and administer the standard in 
Europe. Numerous companies serving international 
markets have since adopted the standard, which has been 
recognized by CEN, the European standards coordinating 
organization. HIBCC Standards use FACT Data Identifiers, 
a global ISO Standard for bar coding in use by a multitude 
of industries, including Blood and Blood Products (ISBT), 
Transportation, Electronics, Automotive, Steel and others. 
 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 247

How to use the HIBC. 
HIBC will only be supported in the following barcode 
types: 
CODE 39 
CODE 128 
EAN 128 
ITF 2/5 
CODABLOCK F 
CODABLOCK F is a 2-dimensional barcode. This barcode 
can be reached from the menu option: 'Field | Codablock 
barcode…' 
The HIBC barcode contains 2 data structures, primary and 
secondary. 

Supplier labeling data structures 

It is intended that all health care products be labeled with a 
primary symbol, which identifies the labeler, the product 
code and unit of measure. The secondary information is 
useful to the distributors and providers and, at the 
discretion of the labeler, should be added. 

Primary data structure 

The primary data structure contains an indication of the 
labeler of the item, the item, the packaging level, and a 
Link Character.   
The labeler identification is a data element that is 
controlled by either the Health Industry Business 
Communications Council (HIBCC), or its affiliate 
international organizations, the Uniform Code Council 
(UCC) or the International Article Numbering Association 
(EAN).  A labeler that chooses to utilize the HIBC Labeler 
Identification Code (LIC) should follow the HIBC LIC data 
and symbology format. A labeler that chooses to utilize the 
UCC/EAN manufacturer identifier should follow the 
UCC/EAN SCC- 1 4 data and symbology format shown in 
this standard and defined by ANSI/UCC-6, Application 
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Standard for Shipping Container Codes.  Note that the 
Food and Drug Administration (FDA) assigns the National 
Drug Code (NDC) and therefore also controls 
manufacturer identification.  A labeler should join the UCC 
to obtain the corresponding UCC Manufacturer 
Identification Number.  UCC/EAN supplier identification 
is also the basis for the small package identification system. 
The HIBC LIC Primary Data Structure format encodes a '+" 
identifier of the HIBC Supplier Data Structure, a 4-
character Labeler Identification Code (LIC), a 1 to 13 
character Product or Catalog Number (PCN), a one-digit 
Unit of Measure Identifier (U/M), and a single-digit Link 
Character (L). 
The Labeler Identification Code (LIC) will be assigned and 
maintained by HIBCC or EHIBCC.  The first character of 
this field will always be an alphabetic character.  The LIC 
may identify a labeler to the point of separate subsidiaries 
and divisions within a parent organization. 
 
The Product or Catalog Number (PCN) should be 
compressed to eliminate embedded spaces and special 
characters.  Special characters must not be used in this field.  
Examples of this compression follow: 
 
 655-9   would become 6559 
 24-86-2S  would become 24862S 
 84/XPG  would become 84XPG 
 MP 15 86-G would become MP1586G 
 92.885*BK  would become 92885BK 
 
This compression impacts only the machine-readable 
representations of the PCN and its associated human-
readable interpretations.  Other external package markings 
and catalog listings covered by this standard remain the 
prerogative of the individual labeler. 
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The Unit-of-Measure Identifier (U/M) is a numeric 
representation of the relative level of packaging (O to 9) 
with 0 being the lowest level or "unit-of-use".  For example, 
a labeler might pack unit-of-use items in a box, boxes in a 
carton, and cartons in a case. One-way of labeling this 
example would be, unit-of-use = 0; Box = 1; Carton = 3; and 
Case = 5. It may be that a unit-of-use is packaged, however, 
in a box.  For instance, individual cotton swabs would be 
considered the unit-of-use and may go unmarked. 

Secondary data structure 

Optional secondary data elements are used in conjunction 
with primary data elements to encode quantity and/or 
expiration (expiry) date and/or Lot/Batch/Serial Number.   
HIBC LIC Secondary Data Structure The format for the HI 
BC Secondary Data Structure, whose maximum length is 
33 characters, follows: 
 

Field 
Descriptor 

Field Length Description 

+  HIBC Supplier Labeling Flag 
Character, 

R 1, 2 or 5 Quantity/Date Reference 
Identifier Numeric: If the first 
character is numeric, then R 
is a fixed 5-digit Julian date. 
No quantity or 
Lot/Batch/Serial Number is 
present. 
$: If the first character is a '$" 
and the second character is 
alphanumeric, then the 
Quantity and Date fields are 
not used. Only a 
Lot/Batch/Serial Number is 
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present. 
$$: If the first two characters 
are '$$", then the next digit 
specifies quantity and Date 
Field format. 

Q 0, 3 or 6 Quantity Field, format 
indicator followed by two-
digit or five-digit quantity, 
for use after the "$$". 

D 0 or 5-9 Date Field, for use after the 
"$$" (includes the date field 
format indicator). 

B 0-13 Lot/Batch/Serial Number 
Field. 

L 1 Link Character (same as the 
last character from Primary 
Data Structure). 

C 1 Modulus 43 Check Character 
(calculated from the above 
characters 

 

Note: The HIBC Secondary Data Structure is distinguished 
from the Primary Data Structure in that the Primary Data 
Structure has an alphabetic character following the HIBC 
Supplier Labeling Flag Character while the Secondary Data 
Structure has a numeric character or a "$" following the 
HIBC Supplier Labeling Flag Character. 
 

Adding a HIBC barcode on the label 

Make a new label, see ' PART 1, Making a new label' for 
closer description. When the label is shown on screen select 
'Field | Barcode…'. You will then be shown the following 
dialog box: 
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Select HIBC, and a new button will appear below the 
button 'Dates…'. 

 

 
 

Press the new button 'HIBC…' and the 'HIBC Barcode 
Format Specification' dialog box is shown:   
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This barcode specification will default be added with 
Primary and Secondary data structure in Concatenation. If 
you are going to use this by linking to separate barcodes 
(primary and secondary) the barcode's must be named 
with a similar name (Example BAR1 and BAR2) .The 
program will then link these two barcodes against each 
other. 
First step would be to add a LIC to the HIBC. This field 
will be max 4 characters and the first must be a letter.  
Then add the PCN. This field will be max 13 characters 
long. 
Last step in primary would be to add the U/M (unit of 
measure). This field will only be one character long. 
NOTE! If you are using 9 the U/M is set to be variable and 
is to be followed by a manual input (when using EDIC) or 
that this is concatenated with the secondary data structure. 
In our example we are using 9. 
Then we must add the secondary data structure to the 
barcode. 
First we must specify the Q.D.Ref (quantity/ date 
referencer ID). Since we have used U/M like 9, there is 
only one option available to us: '$$' 
Press the radio button to the left of $$. 
Then enter the quantity 2 or 5 digits. 
Next step is to select what date format you are going to use. 
Press the radio button to the one you want to use. Then 
add the data into the text box below the format selections. 
The last entry would be the LOT no. If every thing is done 
correct you would see the check character in the last 
textbox (gray color) and the button 'OK' will be black. 
Below is the dialog box showed: 
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  The label will look like this: 
 

 
 

The same barcode when using Codablock F will look like 
this: 

 

 
 

The Codablock F dialog box will be shown as this: 
 



 

오류! 스타일이 정의되어 있지 않습니다. / 오류! 스타일이 정의되어 있지 않습니다. 

 254 

 
 

If you press the button 'HIBCC…' you will see the 
following dialog box: 

 

 
 

When defining a variable HIBC barcode for Codablock F 
the user will see the previous dialog box. When marking 
the "var" boxes the field will be implemented as variable 
data input fields. These fields will be shown for the 
operator to be updated when printing a label. 
If you want these fields to be viewed on the label as a 
standard text field, give the Codablock F barcode a name. 
The content of the Codablock F barcode will the be found 
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as a field name when selecting the option from other field 
in the text field dialog box.
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Part 6: PrintMaster 
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Introduction  
PrintMaster is a program that will allow users to simplify 
the printing process by implementing a simple user 
interface to print labels. The program will be a drag and 
drop printing system. You will see a list of labels in a 
directory that you can drag and drop over a printer to print 
the selected Label. 
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How to use the program  

Starting the program  

To start the program, select the icon    PrintMaster in 
the LabelCraft program group. When you start the 
program you will see a logon screen. 
Note! By default the system does not show the logon screen. 

 
Default login name is: A  
Default password is: 1 
Press the OK button and the program will be ready for use. 
You will see two dialog boxes on the screen:  
PrintMaster 

 
and the preview screen: 
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At start up both screens are blank. When you select a label 
from the “file three” of the left side of the PrintMaster 
dialog box a preview of the label will be shown in the 
preview box and the available printers for this label will be 
shown in the right side of the dialog box. 

 Printers that is online will be shown with a   in the 
printer box. 

 
If the printer is not online the printer box will be shown 
like this: 
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Printers, where LabelCraft has implemented a two-way 
communications, will then show the status of the printer 
and the well as the ribbon length available if that is 
supported in the driver. 

How to print a label.  

Select a label, sample.lbl. Available printers for this label 
will now be shown in the PrintMaster window and the 
preview for this label. Drag the icon (file name) for the 
label and drop it on the top of the printer. The Print dialog 
box will now be shown. 

 
Set the number of labels to be printed and press the button 
“Yes”. The system will print the specified the no. of labels.  

Using the toolbar.  

The toolbar consist of 4 icons 

 Setup icon which allows you to set up the 
different parameters in the system 

 Preview icon, which will toggle on and off the 
preview pane. 

 Delete printer icon, which will delete the selected 
printer from the printer panel. 

 The about icon, which will open the dialog box 
“About PrintMaster”. 
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PrintMaster reference guide  
The program consists of a menu and a toolbar that will 
allow the user to setup the system and using short cuts. 
When the program opens up and a correct user and 
password has been added the following screen will be 
shown: 

 

File | Setup: ”Setup” dialog box  

Use this menu option to modify the program setup. When 
you choose File | Setup, you will see the “Setup” dialog 
box: 

 
This dialog box consists of two tab sheets;” Settings” and 
“Settings”.  
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The first sheet allows the user specify which paths and 
program to open for label preview and editing.  
NOTE! Use the parameters -e and -i in order to show the labels 
correct and not to be stopped by the main window in the software. 
The second sheet, Settings, will allow the user to modify 
the printing and control settings. 

 
Default no.  
labels to print: 

Here you will set up the number of labels to be the default 
print quantity. 

Start print after 
drop 

This option will allow you the disable printing. Please 
note that if this option is turned of (un-hatched) you will 
not be able to print any labels. 

Printer icon  When selecting this option you will be able see a printer 
icon in the printer view. 

Label preview When selecting this option you will be able to see a small 
preview of the selected label instead of a printer icon in 
the printer view 

Poll 
interval(ms) 

Here you set the timing between each polling of the 
printer status. 

OK This button will save the setting. 
Cancel This button will cancel all settings that have been done. 

File | User admin: “User Administration” dialog 
box 

Use this menu option to modify the user administration. 
This function is only available if you are using a 
PrintMaster version with Password enabled. When you 
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choose File | User admin, you will see the “User 
Administration” dialog box: 

 
Only a user with admin rights can only open this dialog 
box. 

New…   This button will allow you to add a new user to the 
system. When pressing this button you will see the dialog 
box “New User”. 

  
Change 
Password… 

This button will allow you change the selected user 
password. This is done in the “New User” dialog box. 
Note! If the password is lost, you must delete the user and 
add him/her into the system as a new user. 
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Delete This button will delete the selected user.  
NOTE! No warnings are issued! 

OK This button saves the changes. 
Cancel This button will close the dialog box without the saving 

the settings on screen. 
 

File | Login New User: “LogIn” dialog box  

Use this menu option to change user that is logged in. This 
function is only available if you are using a PrintMaster 
version with Password enabled. When you choose the 
menu File | Login New User, you will see the “LogIn” 
dialog box:  

 
Login name: Write the user name in this text box.    
Password: Write the password in this text box. 
OK This button will start the login with the supplied data 

from the two text boxes. 
Cancel This button will cancel the login. 

File | Language: “PrintMaster” dialog box  

Use this menu option to change the available language. 
When you choose File | Language, you will see 
the ”PrintMaster” dialog box:  

 
In the dropdown list box you will see the available 
languages that can be used. Click on the language that you 
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want to use and press the “OK” button to confirm your 
selection. 

File | Exit  

Use this menu option to exit the program.  

View| Toolbar  

Use this menu option to show the toolbar in the program. 

 

File | Status Bar  

Use this menu option to show the status bar in the bottom 
of the program window.  

 

File | Label Preview  

Use this menu option to show the preview window.  

 
Close This button will close the preview window. 
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Edit This button will open the label editor. In the top left 
corner of the editor screen you will see this dialog box: 

 
When you have modified the layout press the button 
“Back to PrintMaster” for returning to the PrintMaster 
program. If you forgot to save the label before pressing 
the button you will be asked if you want to save the 
changes. 
NOTE! If you are running with password/user 
management only people with administrator rights will 
see the button “Edit”. 

File | Event Log: ”Event Log” dialog box  

Use this menu option to open the event log. When you 
chose File | Event Log, you see the “Event Log” dialog box. 

 
OK This button will close the Event Log window.  

This button will copy the text to the clipboard. This data 
can now be added into a text editor like notepad by using 
a paste command 

Copy to 
clipboard 

This button will copy the text to the clipboard. This data 
can now be added into a text editor like notepad by using 
a paste command 
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File | Save Screen State  

Use this menu option to the current screen setup as 
windows size and placement.  

Edit | Remove Selected Printers  

Use this menu option to remove the printers that has been 
selected.  

Edit | Remove All Printers  

Use this menu option to remove all the printers.  

Edit | Label Editing  

Use this menu option to edit the selected label in 
LabelCraft. LabelCraft will now be opened. To return to the 
program, press the button “Back to PrintMaster”. 

Help | About PrintMaster.: “About PrintMaster.. 
dialog” box.  

Use this menu option to view what version of PrintMaster 
that you are using. When you choose Help | About 
PrintMaster, you see the “About PrintMaster” dialog box. 

 
Modifying the printer icon  
Sometimes you want to use own printer symbols to 
simplify the identification of the printers. You are able to 
modify these if the setup of the program has been setup to 
show printer icon. Right click the selected printer and you 
will see the “Printer icon” dialog box. 
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… This button will open a dialog box for setting/searching 

for the bitmap to be used.  
Note! Only BMP files can be used! 

OK This button will save the selected bitmap as the one that is 
to be viewed on the screen. 

Cancel This button will cancel the changes done in this session. 
There is also a manual way of setting up what printer icons 
to be using. Then you must edit the “PrintMaster.ini” file 
manually. In the section [UserGraphic] you are able to add 
the path and file names. Please see the extract below: 
[UserGraphic]  

PRINTER0=C:\Label32\bitmaps\labelcrf.bmp  

PRINTER1=  

PRINTER2=  

PRINTER3=  

PRINTER4=  

PRINTER5=  

PRINTER6= 

Printer 0 is the first printer in the printer list in the 
LabelCraft software. If you intend to use the graphic for 
signaling to user what printer and location changes in the 
setup can ruin your system. If you want to remove the 
bitmaps you must do this by manually remove it from the 
ini file. 

Default login name and password  

The system is set-up with a default user with admin. rights. 
This user is:  
Username:    A 
Password:    1 


